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Conventions used in this manual
Filenames, commands typed in at the command prompt are written in typewriter font:

pqsview aspirin.out

The term mouse click refers to the left mouse button being pressed.

The term mouse drag refers to holding down the left mouse button while moving the mouse.

The term icon refers to an object in the graphical user interface, which is a small image usually on top of a button.

The term button refers to an object in the graphical user interface, which triggers an action when activated.

The term radio button refers to an object in the graphical user interface, which is usually grouped with a set of other
objects of the same type. These objects are mutually exclusive, i.e., only one of the objects can be active at a time.

The term slider bar refers to an object in the graphical user interface, which has an associated range of values and can be
adjusted within this range.

The term entry refers to an object in the graphical user interface, which accepts text input.
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Chapter 1
Introduction

PQSMOL is the graphical user interface that can be used in conjunction with the PQS ab initio program. It contains
a model builder with two built-in molecular mechanics force fields together with options for job input preparation, job
submission (serial or parallel), and post-job visualization and display. The latter includes visualization of molecular orbitals
(canonical, localized and natural), electron densities and electrostatic potentials, optimization history (energy/geometry at
each cycle of a geometry optimization), dynamics trajectories, animation of vibrational modes, and simulation of IR/Raman,
VCD and NMR spectra.

Figure 1.1: PQSMol in action

There are two modes of operation for PQSMOL: build mode and view mode. Build mode, as the name implies, is
for building a new molecule or modifying an existing one. View mode is for visualization of already computed quantities.
Structures read into PQSMOL in view mode cannot be modified.
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1.1 Starting PQSMol

In view mode there is one main View window and several additional windows for displaying various properties. In build
mode there are two: the main Build window and the Segment window. The latter provides access to the various fragments
and ”building blocks” from which new molecular structures can be constructed. As well as using predefined fragments, you
can build your own fragments and store them for future use.

Within build mode, you can choose either restricted mode (the default) or unrestricted mode. In restricted mode,
molecules can be constructed only using well-defined building blocks that are recognized by either of the two available
force fields; this ensures that any molecule that is built can be optimized using one or the other of these force fields. In
unrestricted mode, all generic structural motifs are accessible for any atom in the periodic table. Additionally, one can
add (and delete) valency (”bonding”) to any atom, increasing (or decreasing) the number of bonds that can be made to
other atoms. The nature of a bond (single, double, aromatic etc...) can also be changed. In other words you can build just
about anything. However, the downside is that, once you have switched to unrestricted mode, there is no guarantee you
will be able to optimize the geometry of your system, as many atom types may no longer be recognizable by the force fields.

The basic idea then is to build your system, using a combination of well-defined atom types (or building blocks) and
predefined structural fragments, optimize the structure using either of the two available forcefields, possibly symmetrize
the resulting geometry and then prepare the input for, and submit, a PQS job. The job can be submitted either in serial
or parallel, in the background or to a job queue, depending on what options are available on the particular machine. When
the job has finished, various results can be visualized.

If you are already familiar with existing model builders (such as SPARTAN, PCModel or MAESTRO) then you should have
no difficulty in using PQSMOL which is fairly intuitive. Build commands are accessed via drop-down menus and toolbars
(you need a three-button mouse; right, left and center mouse buttons are all potentially active).

The plan from here on is to describe all of the build/visualize tools available in PQSMOL and how to use them. The vast
majority are accessed through various buttons in either the upper or lower toolbar in the main (Build/View) window. The
icons have some pictorial relationship to the actual function they represent, and simply positioning the mouse pointer over
a button will display a tooltip with a brief description of its functionality. Following a description of all the build/visualize
tools, several tutorials will be presented covering all aspects of PQSMOL, including building a molecule, input preparation,
job submission and displaying the final results.

1.1 Starting PQSMol

To start PQSMOL in build mode from the command line prompt, type the following command and press <Enter>:

pqsmol

To start PQSMOL in view mode type:

pqsview

and press <Enter>.

You may also start PQSMOL with a specific file name passed as a command line argument:

pqsmol filename

This command will launch PQSMOL in build mode and open the file filename. The only valid file extension in build
mode is .pqb. In view mode there are several input file types available:
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Introduction

pqsview filename

where the filename extension may be one of:

inp standard PQS job input file.
coord PQS coordinate file.
out PQS job output file.
log PQS job log file.
mop MOPAC input file.
car Biosym CAR file.
zmat Z-Matrix input file.
hin Hyperchem input file.
xyz XYZ coordinate file.

Please report any problems with PQSMOL by email to tech@pqs-chem.com.
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Chapter 2
Build mode

When PQSMOL is started without command line arguments the application runs in build mode. In Figure 2.1 individual
components of the interface are labeled and surrounded with colored rectangles.

Figure 2.1: PQSMol executing in build mode

The main window is divided into two vertical frames. One frame contains the Build window labeled in red, and the other
the Segment window labeled in green. The Build window contains a menubar - purple, simple action toolbar - olive, the
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2.1 Build window

build area - yellow, the build toolbar - brown, and the statusbar - blue.

The Segment window provides access to a set of basic building blocks, a library of fragments, and a clipboard. The Building
Blocks tab, the Fragments tab and the Clipboard tab are labeled in black. The Segment buffer which displays segments to
be inserted into the build area is labeled in orange.

2.1 Build window

Figure 2.2: The Build window
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Build mode

2.1.1 Toolbars

The majority of actions available in PQSMOL are accessible through the two toolbars in the main window. Each toolbar
button has an icon and a tooltip to identify its action. The top toolbar contains buttons for simple tools that require no
interaction with the Build window. The bottom toolbar groups more complex tools, that often require multiple clicks in the
Build window to complete their function. Information for each of these tools is displayed in the statusbar at the bottom of
the Build window.

Buttons with a dark triangle in the lower right corner have options available through a drop down menu. To access the
menu right-click on the button.

Tip: To show any button’s tooltip move the mouse pointer over the button.

Simple action toolbar

Simple, single-click tools in PQSMOL are grouped in the top toolbar.

Figure 2.3: Simple action - top toolbar

Buttons from left to right are:

Hydrogen Fill
Fills all free single valencies (vacant single bonds capped with green translucent dummy atoms) with hydrogen atoms.

Optimize
Performs a geometry optimization on the current structure using the currently selected force field. See Section 2.4.

Check Symmetry
Determines the molecular point group symmetry. See Section 2.5.

Select All
Selects everything (all atoms and bonds) in the Build window. Subsequent build operations, such as Cut, Paste, are applied
to the complete structure.

Select None
Deselects all atoms and bonds that are currently selected.

Center All
Positions the current structure in the center of the Build window.

Parallel Quantum Solutions 7



2.1 Build window

Face Front
Rotates the current structure so that the XY plane is parallel with the screen.

Copy
Copies that part of the structure that is currently selected into the clipboard and displays it in the Segment buffer.

Note: The copy operation automatically activates the Clipboard tab in the Segment window.

Cut
Copies that part of the molecule that is currently selected into the clipboard, displays it in the Segment buffer, and removes
it from the Build window.

Note: The cut operation automatically activates the Clipboard tab in the Segment window.

Paste
Pastes the contents of the clipboard into the Build window.

Undo
Undoes the effects of the last operation (i.e., the last change made to the current structure in the Build window).

Redo
Re-does the effect of the last operation before the undo (i.e., undoes the undo).

Note: Multiple undo and redo operations are supported.

Note: Actions performed in the Build window form a list of build events. Each item in the list
stores a structure which is a result of all previous build events stored in the list. The undo operation
moves backward through the list. The redo moves forward through the list. If the beginning of the
list is reached, the undo operation becomes inactive. If the end of the list is reached then the redo
operation is no longer available. In a situation where a new operation is inserted in the middle of the
list, all subsequent list items are destroyed and the resulting geometry is stored as the last item in the
list.

Drawing Plane
Toggles on/off the drawing plane.

Note: The drawing plane is defined by three user-selected atoms in the molecule. If these are not
defined, the Define drawing plane tool from the bottom toolbar is automatically selected.
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Build mode

Atom Labels
Toggles on/off atom labels.

Coordinate Axes
Toggles on/off the coordinate axes.

Note: The spacing between the tic marks on each coordinate axis is one Angström.

Hydrogen Hide
Shows or hides hydrogen atoms.

Info Window
Toggles on/off the info window, see Section 2.32.

Build tools toolbar

The bottom toolbar groups complex tools. Use these tools to interact with the objects in the Build window.

Figure 2.4: Build tools - bottom toolbar

The tools from left to right are:

Default tool
The primary action of the default tool is rotation of the molecule.

Usage: Drag the mouse vertically and horizontally to rotate the structure along the X and Y axes, respectively. Press the
<SHIFT> key while dragging to rotate around the Z axis (i.e., out of the plane of the Build window).

To speed up the building process for advanced users, the Default tool is overloaded with additional actions.

1. Add/Attach/Connect
Use the right mouse button to perform the same actions as described in the Add/Attach/Connect tool.

2. Zoom
Drag vertically using the center mouse button.

3. Select
Press the <SHIFT> key while clicking the center mouse button to perform actions described in the Select tool.

4. Move
Press the <CONTROL> key while clicking the center mouse button to perform actions described in the Move tool.

Parallel Quantum Solutions 9



2.1 Build window

Note: Each of the overloaded actions is available through its own dedicated tool button. The
Default tool is the only tool that uses buttons other than the left. The remainder of the PQSMOL

tools use only the left mouse button.

Zoom tool
Moves the viewpoint directly over the center of the selected area of interest and zooms in to show the atoms within.

Usage: Drag the mouse over the area of interest to zoom in. Double click to return to full view.

Note: In the full view (zoom out) the origin of rotation is the center of the coordinate system
(point {0.0, 0.0, 0.0}). The zoom operation effectively changes the origin of rotation for the molecule
to be the center of the selected area of interest.

Info tool
Displays information about atoms, bonds, distances, angles, torsions and out-of-plane bends. For each atom the information
includes atom type, atom position in the input geometry, assigned symbols for Sybyl5.2 and Universal force fields and the
Cartesian coordinates. This information is displayed in the info window at the bottom of the Build window. The info
window is automatically opened when the Info tool is selected. It is not, however, automatically closed when a different
tool is selected. Use the Info Window button in the simple action toolbar to close the info window.

Usage: Click on any atom to get its coordinates, click on two atoms to get the distance between them, click on three
for the 1-2-3 angle and click on four to get the 1-2-3-4 torsion and out-of-plane bend. To clear the current info selection
double-click over empty space in the window.

Tip: This tool also works with bonds. Click on any bond to get its length, any two adjacent bonds to
get the angle between them, or any three bonds sharing two atoms to get the torsion and out-of-plane
bend.

Add/Attach/Connect tool
The tool performs three distinct actions. The Add action inserts the current segment in the Segment buffer into the Build
window. The Attach action attaches the current segment in the Segment buffer to a structure inside the Build window.
The Connect action is used to connect two atoms which are already inside the Build window.

Usage:

1. Add
Move the mouse pointer over empty space in the Build window. The mouse pointer changes to

Click to insert the segment displayed in the Segment buffer into the Build window at the location of the mouse pointer.

2. Attach
Move the mouse pointer over an atom. If the atom is a compatible attachment point the mouse pointer changes to

and the atom under the pointer is highlighted. Click to attach the segment displayed in the Segment buffer to
the molecule in the Build window at the selected attachment atom. If the atom under the mouse pointer is not a
compatible attachment point the mouse pointer changes to
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3. Connect
Move the mouse pointer over an atom, click and drag the mouse to a second atom. If the second atom is a valid
connection point the cursor changes to

Release the mouse button to create a bond between the two atoms. If the atom under the mouse pointer is not a
compatible connection point the mouse pointer changes to

Tip: At all times, a single atom in the structure in the Segment buffer is highlighted. This atom is
the attachment point for the segment. During the attach operation, this atom will be replaced with
a bond connecting the newly inserted segment with the structure inside the build area. You can change
the attachment point of the segment by clicking on any atom that has just one bond connecting it to
the reset of the segment.

Move tool
Repositions selected atoms and bonds inside the Build window. This tool’s functionality depends on the state of the
Auto Selection mode. With Auto Selection mode enabled, a selection is automatically applied to the entire segment
containing an atom to be moved. The whole segment is then moved. With Auto Selection mode disabled, a manual
selection is required before using the Move tool. Although an additional step is required, this mode offers more control
over atom and bond movement.

Usage: Move the mouse pointer over an atom and click. If the Auto Selection option is on, the segment containing the
atom is selected and highlighted with a gray translucent surface. Drag the segment to the desired location and release the
mouse button.

If Auto Selection mode is off, first select the atoms to move using either the Select or the Select Segment tool. Then
using the Move tool, drag the selection to the desired location.

Tip: To change the Auto Selection click on the Auto Selection area in the statusbar or use
the Build→Auto Selection item in the main menu bar.

Select tool
The Select tool works in two ways. It either selects individual atoms and/or bonds or can be used to create rectangular
selection areas selecting any objects they encompass. The selected atoms and bonds are surrounded by a translucent gray
surface. Selection operations are cumulative.

Usage: Form a rectangular box (selection area) which selects all atoms in the box for a subsequent action (e.g., Cut,
Move), by clicking anywhere in the build area (close to the atoms to be selected) and dragging the mouse horizontally and
vertically to define the box dimensions. Releasing the mouse will complete the box definition. The selected atoms and
bonds are surrounded by a translucent gray surface. To toggle the selection of an individual atom or bond, click on the
atom or on the bond.
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2.1 Build window

Note: The Box Selection mode is the default behavior of the Select tool. The alternative
mode of operation is Segment Selection, in which a mouse click over any atom will select the entire
segment (all connected atoms) containing the atom. To switch between the two modes, right click over
the Select tool button and choose the desired mode from the drop down menu.

Figure 2.5: Selection

Selections can be cleared with the Select None button in the simple action toolbar.

Tip: Double-clicking in the build area will clear all selections, regardless of the current tool.

Hide Nonessential
Deemphasizes atoms which are not part of the area of interest.

Usage: Drag the mouse over the area of interest. The atoms inside the selected area are unchanged. Outside of this area
all Hydrogen atoms become hidden and only the bond structure for the remainder of atoms is shown.

Tip: This tool is particularly useful while building large molecules (100’s of atoms) to reduce the
atom clutter on the screen. Use it in conjunction with the Zoom tool to easily locate attachment
points in large molecules.

Bond Length tool
Adjusts the length of a bond.

Usage: Click on a bond to select it for length adjustment. The selected bond is highlighted and its length is displayed in
Angströms.

The selected bond partitions the atoms in the system into two groups: stationary and active. The active group is surrounded
by a gray translucent surface. The stationary group is unaffected by the bond length adjustment. All atoms in the active
group will move when the bond length is adjusted. Dragging the mouse up/down will increase/decrease the bond length.
Double-click to set the length. Double-click while pressing the <SHIFT> key to set the default length for that bond.
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Build mode

Figure 2.6: Bond length adjustment. The active group is surrounded by a gray translucent surface.

Tip: To modify the active group, switch to the Select tool and click on a stationary atom to add
it to the active group or on an active atom to remove it from the group. Switch back to the Bond
Length tool to adjust the bond length with the modified active group.

Tip: Press the <SHIFT> key while adjusting the length of the bond to slow down the rate of change
and increase accuracy.

Bond Angle tool
Adjusts the angle between two bonds.

Usage: Click on two adjacent bonds to select the angle for adjustment. The selected bonds are highlighted and the angle
between them is displayed in degrees. All atoms connected to the open end of the second selected bond are added to the
active group and are surrounded by a gray translucent surface. Only the atoms and bonds in the active group are affected
by the bond angle adjustment. Drag vertically to change the angle. Double-click to set the angle.

Figure 2.7: Bond angle adjustment

Tip: Press the <SHIFT> key while dragging the mouse for more accuracy in setting the angle.

Bond Torsion tool
Adjusts the torsion of three selected bonds. The active group in the Bond Torsion tool includes all atoms and bonds
connected to the third selected bond not including the rotation bond, as shown in Figure 2.8.
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2.1 Build window

Usage: Click on three adjacent bonds to select the torsion angle for adjustment. The selected bonds are highlighted and
the torsion angle between them is displayed in degrees. All atoms connected to the open end of the third selected bond are
added to the active group and are surrounded by a gray translucent surface. Only the atoms and bonds in the active group
are affected by the torsion angle adjustment. Drag vertically to change the torsion angle. Double-click to set the torsion
angle.

Figure 2.8: Bond torsion angle adjustment

Tip: Press the <SHIFT> key while dragging the mouse for more accuracy in setting the torsion.

Rotate About a Bond tool
Adjusts the torsion of three automatically selected bonds. The bond selection is based on the rotation bond you select.
The active group in Rotate About a Bond tool includes all atoms and bonds on one side of the rotation bond, as shown
in Figure 2.9. In essence, this tool twists one part of the molecule with respect to the other around the rotation bond.

Usage: Click on a bond to select the axis for rotation. The selected bond is highlighted. An adjacent bond is automatically
selected on each side of the selected bond. The torsion and out-of-plane bend are displayed in degrees. All atoms connected
to one end of the axis of rotation bond are added to the active group and are surrounded by a gray translucent surface.
Drag vertically to change the torsion angle. Double-click to set the angle.

Figure 2.9: Rotation about a bond

Tip: Press the <SHIFT> key while dragging the mouse for more accuracy in setting the torsion.
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Note: The axis of rotation bond divides the molecule into two groups. By default the active
group is composed of atoms in the group which contains the smaller number of atoms. To force the
selection of the larger group of atoms right click on the Rotate About a Bond button and select
Larger Secion.

Bond Break tool
Breaks a bond.

Usage: Click on a bond to break it. To preserve the correct atomic valency, the broken bond is replaced by two bonds,
one on each atom, each capped with a dummy atom. Dummy atoms are represented by semitransparent green spheres.

Figure 2.10: Bond break

Bond Fuse tool
The fuse bond tool allows two bonds in separate segments to be fused into a single bond, fusing the two segments together
into a united whole. After fusion, the second of the formerly separate segments is selected and the fuse bond is set as the
rotation bond, allowing the angle between the two sections to be adjusted.

Note: Not all bonds are fusible. A fusible bond has:

• exactly one closed bond on at least one end

• if an end has a closed bond, that end also has at least one open bond

An open bond is a bond that is connected to an atom with a valency of one, i.e., no other bonds are
connected to the atom. A closed bond is one which is connected to atoms with valencies higher than
one at both ends.

Usage: Move the mouse pointer over a bond. If the bond is fusible, it will be highlighted with a yellow translucent surface.
The surrounding open and closed bonds will be highlighted with a green translucent surface. Click on the bond to select it
as the fuse bond. Move the pointer over a matching fuse bond in a separate segment.
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Note: A matching fuse bond has:

• the same number of open and closed bonds as the fuse bond, at both corresponding ends

If the bond is a matching fuse bond, it will be highlighted with a yellow translucent surface and the surrounding open and
closed bonds will be highlighted with a gray translucent surface. Click to fuse the two bonds.

Figure 2.11: Bond fuse example #1

Note: Bond fusion involves moving one of the two segments so as to fuse onto the other segment
at the position of the fuse bond. During this procedure, the segment containing the initially selected
fuse bond will remain stationary, while the second segment will move. Bear this in mind if there are
other segments in the Build window whose position relative to one or other of the segments to be fused
you wish to remain unchanged.

When the segments are fused, the newly fused bond is automatically selected as the axis of rotation and all atoms and
bonds in the matching fuse bond segment are added to the active group. Drag the mouse vertically to adjust the dihedral
angle. Double-click to set.
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Figure 2.12: Bond fuse example #2

Center on Atom tool
Centers the structure with respect to a specific atom.

Usage: Click on an atom. All atoms and bonds are shifted so that the selected atom is at the origin of the coordinate
system.

Reorient Selection tool
Repositions the current selection with respect to a selected reorient atom. It is useful for reorienting molecules relative to
one another.

This tool’s behavior depends on the state of the Auto Selection mode. With Auto Selection mode enabled, the
entire segment containing the selected reorient atom is automatically selected for reorientation. With Auto Selection
mode disabled, you must first manually select atoms and bonds to reorient, and then use the Reorient Selection tool to
select the reorient atom and reorient the selection. Although an extra step is necessary with the Auto Selection mode
disabled, this method allows segments, or individual unconnected atoms, to be repositioned about any given reorient atom,
not necessarily contained in the segment itself.

Usage: Select an atom to be the reference point for reorientation. The atom is highlighted with a green translucent sphere.
In the Auto Selection mode all atoms and bonds in the selected atom’s segment are added to the active group. Drag the
mouse vertically and horizontally to reposition the atoms and bonds in the active group. Drag the mouse while pressing
the <SHIFT> key to rotate the active group around the Z axis (i.e. out of the plane of the Build window). Double-click
to set.
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Figure 2.13: Reorient example

Note: If Auto Selection mode is off, then the atoms to be reoriented should be selected first
via the Select tool and then the reference atom for the reorientation selected using the Reorient
Selection tool.

Define Draw Plane tool
Defines a drawing plane by selecting three drawing plane atoms.

Usage: Click on three non-linear atoms to define a drawing plane. Each selected atom will be highlighted with a red
translucent sphere. When the third atom is selected, the drawing plane intersecting the three atoms will be displayed.

Figure 2.14: drawing plane

Simultaneously with the drawing plane, the Plane Shift window appears, Figure 2.15. This enables the plane to be shifted
vertically (perpendicular) from its original location, by a specific distance in Angströms. To set the plane shift back to 0
Angströms press the Reset button.
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Figure 2.15: Plane Shift window

To toggle the drawing plane use the drawing plane button in the upper toolbar.

Snap to Plane tool
Positions structures in the drawing plane as defined by the Define Draw Plane tool. Up to three selected atoms can
be position in the drawing plane. The segment (possibly segments) containing these atoms are moved accordingly. The
drawing plane must be defined before the Snap-to-Plane tool can be used.

Figure 2.16: Snap to Plane example - starting configuration

Usage: Click on an atom in the structure to be reoriented. The selected atom is highlighted with a green translucent
sphere. All remaining atoms in the segment are added to the active group and the segment moves so that the atom selected
is in the drawing plane.
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Figure 2.17: Snap to Plane example - first atom selected

Click on the second atom. The atom is highlighted with a green translucent sphere and all atoms in the active group are
rotated so that the second atom is also positioned in the drawing plane.

Figure 2.18: Snap to Plane example - second atom selected

Click on the third atom in the structure. This atom is also highlighted with a green translucent sphere and all atoms in
the active group are rotated so that all three selected atoms are positioned in the drawing plane.

Figure 2.19: Snap to Plane example - third atom selected

Note: This tool is only available if the drawing plane is turned on.
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Replace tool
Replaces any atom in the current structure in the Build window with any other atom in the periodic table.

Usage: Click on the atom in the periodic table you wish to substitute. Click on any atom in your current structure to
replace that atom with an atom of selected element type. All bonds to that atom will remain as they were, both with
respect to distance and angles.

Note: This tool is only available in unrestricted mode.

Add Valence tool
Adds a free valence to an atom allowing another bond to be formed to that atom . The new bond will be automatically
positioned as far away geometrically from any existing bonds (up to three) as possible. Once four or more bonds are already
present, the new bond will be placed in the same location every time and will have to be moved into an appropriate position.
When the free valence is in place, other building blocks can be added to it using the Add/Attach/Connect tool.

Usage: Click on an atom to add a valence. A new bond capped with a dummy atom is added to the selected atom. Drag
the mouse horizontally and/or vertically to rotate the new bond along the X and Y axes, respectively. Press the <SHIFT>
key while dragging the mouse to rotate the bond about the Z axis (i.e., out of the plane of the Build window).

Figure 2.20: Add Valence example

Note: This tool is only available in unrestricted mode.

Remove Valence tool
Removes monovalent atoms and their valencies.

Usage: Click on any monovalent atom to delete it from the current molecule.

Note: This tool is only available in unrestricted mode.

Bond Type tool
Changes the bond type for a bond.
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Usage: Click on a bond to change its type. Each click will advance the bond type to the next element in the following list:
Single→Double →Triple →Amide →Aromatic

Tip: To set a specific bond type on the first click, right click on the Bond Type button and select
the desired bond type.

Note: This tool is only available in unrestricted mode.

2.1.2 Menu

At the top of the PQSMOL main window is the menubar, Figure 2.21. Almost all of the functions of PQSMOL are
available by activating the appropriate menu item. The functions have been grouped according to their type.

Figure 2.21: The PQSMol Menubar in build mode

The File menu

The file operations have been grouped into the File menu

• Build New starts a new build project. If the currently edited structure has been modified since the last save
operation, you are presented with the Save Changes dialog, Figure 2.22 . The Save button in the dialog saves the

22 PQSMol Manual



Build mode

current molecule. If the project is untitled, the Save As dialog is displayed. The Ignore button in the dialog causes
the last changes in the edited molecule to be lost. The Cancel dialog button cancels the operation.

Figure 2.22: Save Changes dialog

• Open Existing opens an existing build file. The File Open dialog, Figure 2.23, lets you browse directories for a
specific file. The file list is filtered so that only the pqsmol build files, with the .pqb extension, are displayed. You
can change the current browse directory by selecting entries in the Directories list on the left and a specific file can
be selected from the Files list on the right side.

Figure 2.23: File Open dialog

• Import allows a range of different file types (other than .pqb files) to be imported. The Import Geometry dialog is
shown in Figure 2.24.
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Figure 2.24: Import geometry dialog

Note: Imported structures are placed in the clipboard.

The type of file to be imported is selected via the File Type pulldown menu and the actual file is selected in the Files
list.

• Save saves the current structure in the Build window. If the project is untitled then the Save As dialog is displayed.

• Save As saves the current structure in the Build window under an alternative name. The default file type is the
PQSMOL build file .pqb. Additionally, .coord and .inp formats are available.
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Figure 2.25: File Save As dialog

Note: The .coord and .inp file formats do not store the connectivity information nor the
force field symbols for each atom. When files of these types are imported into PQSMOL, the
connectivity information, which includes bond types and the Sybyl5.2 and Universal forcefield
symbols, are autodetected.

• Quit exits PQSMOL. If the currently edited molecule has been modified since the last save operation, you are
presented with the Save Changes dialog, Figure 2.22.
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The Edit menu

• Undo undoes the effects of the last operation (the last change made to the current structure in the build area).

Note: Multiple undo and redo operations are supported.

• Redo re-does the last undone operation (i.e., undoes the undo).

• Cut removes the current selection.

Tip: Structures cut or copied from the Build window are placed in the clipboard and may be
reused.

• Copy copies the current selection into the clipboard.

• Paste pastes the contents of the clipboard into the Build window.

• Select All selects all atoms and bonds.

• Select None deselects all atoms and bonds.

• Inverse Selection toggles the selection state of all atoms and bonds. All selected atoms before the operation become
deselected after the operation and vice versa as shown in Figure 2.26.
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Figure 2.26: Inverse Selection example - before (left image), after (right image)

• Inverse Seg. Selection toggles the selection state of all atoms and bonds within segments which have some atoms or
bonds selected. All selected atoms within a given segment before the operation become deselected after the operation
and vice versa as shown in Figure 2.27

Figure 2.27: Inverse Segment Selection example - before (left image), after (right image)
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The Build menu

• Mode→restricted sets the restricted building mode (Section 2.3.3).

• Mode→unrestricted sets the unrestricted building mode (Section 2.3.3).

• Center All centers the contents of the Build window.

• Center Selection centers the selection in the Build window.

• Face Front rotate the structure in the Build window so that XY plane is parallel with the screen.

• Hydrogen Fill replaces all single-bond, dummy atoms with Hydrogen.

• Show Angle Presets toggles the Angle Presets window, Figure 2.28. When enabled, the presets window will
automatically appear whenever a rotation bond is selected or a second bond is selected with the bond angle tool.
Activating any of the preset angles listed will set the torsion about the rotation bond or the bond angle to the selected
preset.
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Figure 2.28: Angle Presets window, left image - torsion presets, right image - angle presets

• Plane Shift toggles the Plane Shift window, Figure 2.15. When enabled, the Plane Shift window will automatically
appear whenever a drawing plane is activated. It is used to shift the drawing plane by a specific distance in Angströms.
To set the plane shift back to 0 Angströms press the Reset button.

• Auto Selection toggles the building mode (Section 2.3.2).

• Auto Torsion toggles the torsion building mode (Section 2.3.1).

• Torsion Options shows the Torsion Options window, Figure 2.29. If the Auto Torsion building mode is active,
PQSMOL attempts to find the minimal energy configuration during an attach operation. When a new segment is
attached to the existing structure inside the build area, it is rotated around the attachment bond starting at a torsion
of 0 degrees. The torsion angle is repeatedly incremented by Degree Step degrees, until a full rotation is completed.
At each point in the rotation the van der Waals energy is calculated using the van der Waals Cutoff, given in
Angströms. The segment is attached at the torsion angle with the lowest van der Waals energy. The Animate
Optimization check box toggles the animation of the torsion optimization process.

Figure 2.29: Torsion Options window
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The Optimize menu

Refer to Section 2.4 for a detailed discussion of the optimization process.

• Force Field→Sybyl5.2 sets Sybyl5.2 as the current force field.

• Force Field→UFF sets UFF as the current force field.

• Force Field→Options shows the Force Field options window, see Section 2.4.1.

• Check Atom Type checks or modifies the Force Field atom types, see Section 2.4.3.

• Options shows the Optimization options window, see Section 2.4.2.

• Optimize executes the optimizer, see Section 2.4.

The Symmetry menu

See Section 2.5 for a detailed discussion of the symmetry operation.

• Check Symmetry executes the symmetrizer, see Section 2.5.

• Options shows the Symmetry options window, see Section 2.5.1.
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The Display menu

• View Mode offers nine viewing modes, which differ from each other primarily in the radii of the spheres representing
atoms and the radii of the cylinders representing bonds. The Skeleton view mode is the fastest to render. It is
recommended for large structures, i.e., containing hundreds of atoms, and slow graphics cards.

• Labels toggles atom labels.

• Coordinates toggles the coordinate axes.

• Hydrogen Hide shows/hides hydrogen atoms.

• Options→Background shows the Background Color window, Figure 2.30.
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Figure 2.30: Background Color window

This allows the background color of the Build window to be set via the slide bars. The background color can also be
selected by positioning the mouse pointer on the small circle inside the large colored circle and dragging the mouse
to the desired location; as the small circle moves, the slide bars will also shift, reflecting the new background color.

• Options→Graphics shows the Graphics Options window.

Figure 2.31: Graphics Options window

This window controls the quality of the graphics, again using slide bars. Moving the slide bars further to the right
increases the corresponding value. High quality graphics will give crisp, clear pictures but will increase the time taken
to display or manipulate any graphical image.

The Calculation menu
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The Calculation menu provides an interface to the PQS program. It controls various aspects of job input preparation, job
submission, job progress monitoring and post-job visualization and display. See Section 2.6 for a detailed discussion on
running a PQS calculation.

• Job Input prepares a PQS input file containing the geometrical structure from the Build window, See Section 2.6.1.

• Submit Job runs a serial PQS calculation, see Section 2.6.2.

• Submit Parallel Job submits a parallel PQS calculation in the background or into a queue, see Section 2.6.2.

• Job Output monitors the PQS output and log files.

• Visualize Output launches PQSMOL in view mode with the output file from the PQS calculation as an argument,
see Chapter 3.

The Window menu

• Segment toggles on/off or repositions the Segment window frame. Selecting the appropriate option will either position
the Segment window frame to the right of the Build window, position it to the left of the Build window or hide it
entirely.

• Info toggles on/off the info window, Figure 2.32.

Figure 2.32: Info window - atom info, top image; bond info - bottom image

The Info window displays information gathered by the info tool. The info tool can collect information about atoms, Figure
2.32 - top image, or bonds, Figure 2.32 - bottom image. If a single atom is selected by the info tool, the atom’s number,
atom’s symbol, Sybyl5.2 and Universal atom types and coordinates are displayed. When a second atom is selected, the
distance in Angströms, between the two atoms is displayed. Selection of a third atom shows the angle between the three
atoms, and selection of a fourth gives the torsion and out-of-plane bend. If the info tool is used to select bonds, a single
bond gives information about the bond number, the atoms it connects, bond type and bond length. Selection of a second
bond gives the angle between the two bonds, and selection of a third shows the torsion and the out-of-plane bend.
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2.1.3 Statusbar

Figure 2.33: Statusbar in build mode

The statusbar displays information about the current status of PQSMOL, Figure 2.33. In the top left corner, the 3D
coordinates of the mouse pointer in Angströms are shown. During the add operation, point (0,0,0) in the segment being
inserted will be aligned with the mouse pointer coordinates. On the top right side of the statusbar the Torsion Mode and
the Selection Mode are shown, as well as the current Force Field.

In the bottom left corner of the statusbar, the name of the Current Tool is displayed. The area to the right is the
Tool Description, which displays information on how to use the tool. The acronyms LMB, RMB and CMB stand for
Left Mouse Button, Right Mouse Button and Center Mouse Button, respectively. In the lower right corner the current
restriction mode is displayed.

The torsion mode, selection mode, force field and the restriction mode can all be toggled via a mouse click in the
corresponding entry in the statusbar.

2.1.4 Useful Shortcuts

• Ctrl+O Open File

• Ctrl+S Save File

• Ctrl+Q Quit

• Ctrl+Z Undo

• Ctrl+Y Redo

• Ctrl+X Cut

• Ctrl+C Copy

• Ctrl+V Paste

• Ctrl+A Select All

• Ctrl+N Select None

• Ctrl+I Inverse Selection

• Ctrl+H Hydrogen Fill

2.2 Segment window

The Segment window provides access to the various fragments and “building blocks” from which new molecular structures
can be constructed. The top area of the Segment window is the Segment buffer. At any time, the Segment buffer stores and
displays the segment which would be inserted into the Build window, if the user executes the insert operation. Immediately
below the Segment buffer there are three tabs. These are labeled: Building Blocks, Fragments and Clipboard. The
Segment buffer is used to display structures selected in all three tabs.
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2.2.1 Building Blocks

The Building Blocks tab contains a periodic table of elements and a Bond Configuration frame. The availability of individual
element buttons in the periodic table, as well as buttons in the Bond Configuration frame, depend on the current force field.
Only elements that are defined in the current force field are available in the periodic table, and only the bond configurations
known to the current force field are available in the Bond Configuration frame.

The currently selected basic “building block” appears in the Segment buffer and can be added to the build area; as shown,
the default is an sp3-hybridized carbon. The force field type currently selected is shown in the statusbar of the Build
window, see Figure 2.33; a click on this box will toggle between the Sybyl5.2 and Universal force fields. The current atom
type is highlighted in the periodic table as a button with a green background; it is also displayed in large font above the
periodic table.

Figure 2.34: Segment window with the Sybyl5.2 force
field selected

Figure 2.35: Segment window with the Universal force
field selected

If the current force field is changed, the bond configuration list changes to contain all the building blocks for the current
atom in the current force field. Also the periodic table changes, activating only the buttons for the elements defined in the
current force field. Note the difference between Figures 2.35 (Sybyl5.2) and 2.35 (Universal). As the Universal force field
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covers essentially the entire periodic table, there are many more atom types (a total of 126) than for the Sybyl force field.

Note that, although all elements are covered in UFF, many metals must have a well-defined coordination (usually octahedral)
or they will either not be properly recognized or distort significantly if a geometry optimization is attempted. In particular,
UFF simply does not recognize a trigonal bipyramidal configuration around a central atom. On the other hand, although
the Sybyl force field has far fewer atom types, there are default values for most parameters, and it can be used even for
atoms for which it was not originally defined.

In these cases, “equilibrium” bond lengths and angles involving unknown atom types will be assumed to have values as
derived from the original geometry. If you are building an organometallic system and have the geometry around the metal
atom more-or-less correct, then you might be better off using the Sybyl force field to optimize the structure rather than
UFF, even though the metal is recognized in UFF but not in Sybyl. Taking idealized geometrical parameters directly from
the input geometry has a couple of side effects that the user needs to be aware of: (1) slightly different starting structures
for the same system will optimize to different final geometries; and (2) if optimized structures are reoptimized, they will
again change. For more details about the Sybyl 5.2 and Universal force fields, see the User’s Guide to PQS.

2.2.2 Fragments

In addition to the building blocks, a large library of preconstructed molecular fragments can be accessed via the Fragments
tab in the Segment window. The available fragments are the same for both the Sybyl5.2 and Universal force fields. Currently
these are grouped under:

• AMINO ACIDS

• BICYCLIC

• CHAINS

• FUNCTIONAL GROUPS

• HETROCYLCIC

• LIGANDS

• MONOCYCLIC

• NUCLEOTIDES

• POLYCYCLIC

• SOLVENTS

• SUGARS

• ORGANOMETALLICS

• TS (Transition States)

All fragments except those in the last two categories have been preoptimized using the Sybyl force field. Fragments in the
TS group are basically templates for common organic reaction transition states; they should not be optimized in the builder
as neither force field is capable of handling transition structures.
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Figure 2.36: Segment buffer with the Fragments tab
selected

Figure 2.37: Segment buffer with the Clipboard tab se-
lected

The actual fragments available under each category are accessible in a list on the left side of the window. Fragments
selected from the list appear in the Segment buffer. As shown in Figure 2.36, when the Fragments tab is first selected, the
first available AMINO-ACID (alanine) is displayed. Note the circle around one of the atoms (nominally a hydrogen atom).
This is the attachment point for the fragment. It indicates where the new bond will form if the fragment is attached to an
existing structure in the build area. The attachment point can be changed by clicking on another open atom in the current
fragment.

2.2.3 Clipboard

The Clipboard tab allows you to manipulate segments copied or cut from the Build window. When a copy or cut operation
takes place in the Build window, the Clipboard tab is automatically selected and the contents of the clipboard are updated
and displayed in the Segment buffer. Once in the clipboard, a segment can be reused and pasted or attached back in the
Build window, possibly multiple times.

The clipboard is also used for importing fragments into PQSMOL. When a fragment is imported, it is first placed in the
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clipboard. This allows you to inspect the fragment and select its attachment point before using it in the Build window.

Additionally, the clipboard is an interface to the USER LIBrary. As well as using the predefined fragments, you can build
your own fragments and store them in the USER LIBrary. The fragment can be constructed in the Build window, optimized
and then selected in its entirety and copied into the clipboard. Once in the clipboard, Figure 2.37, it can be added to the
user’s own fragment library. The fragment has to be given a filename with a .pqf extension in the Save Fragment As text
entry. The .pqf extension is the common extension for all stored fragments. The Add To Lib. button saves the file in
the user’s fragment library, producing the dialog shown in Figure 3.4. The fragment will now appear in the list under the
USER LIB category.

Figure 2.38: Addition to User Library confirmation dialog

Note: User Library fragments are stored by default in the user’s home directory in
$HOME/.pqsmol/fragments/. The default storage location can be changed by editing the line:

user fragments $HOME/.pqsmol/fragments

in the system-wide pqsmol.conf configuration file.

2.3 Building Modes

There are three building modes in PQSMOL:

• Auto Torsion

• Auto Selection

• Restricted/Unrestricted mode

The status of each mode is displayed in the statusbar, Figure 2.39

Figure 2.39: Statusbar with the Building Modes highlighted

All three modes may be toggled by either clicking in the appropriate area in the statusbar or activating the corresponding
menu item: Build→Auto Torsion, Build→Auto Selection, and Build→Mode.
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2.3.1 Auto Torsion

When the Auto Torsion mode is active, PQSMOL attempts to find the minimal energy configuration for the resulting
structure during the attach and connect operations. When a new segment is attached to the existing structure inside the
build area, it is rotated around the attachment bond starting at a torsion of 0 degrees. The torsion angle is repeatedly
incremented by a specified number of degrees (see Figure 2.29), until a full rotation is completed. At each point in the
rotation the van der Waals energy is calculated using a specified van der Waals Cutoff, (see Figure 2.29). The segment
is attached at the torsion angle with the lowest van der Waals energy.

Note: The Auto Torsion option affects the attach and connect operations only.

2.3.2 Auto Selection

When the Auto Selection building mode is active, PQSMOL automatically selects the entire affected segment during the
move and reorient operations, Figure 2.40 right image.

Figure 2.40: Move operation with Auto Selection off (left) and on (right)

The move operation will only modify atoms which are currently selected. If the Auto Selection mode is inactive and no
selection is made, move will have no effect on the structure in the Build window. However, in this mode it is possible to
make custom selections which do not involve all atoms in a given segment. This is illustrated in the left image of Figure
2.40, where only the center Carbon atom is selected and moved.

Note: The Auto Selection option affects the move and reorient selection operations only.

2.3.3 Restricted/Unrestricted

There are two restriction modes available in PQSMOL: restricted and unrestricted. The two modes control the amount
of freedom you have when constructing molecules. The restricted mode is the default mode of operation. In this mode,
molecules can be constructed using only the well-defined building blocks that are recognized by either the Sybyl5.2 or the
UFF force field (see Figure 2.41, left image). This ensures that any molecule that is built can in fact be optimized using
one or the other of these force fields.
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You can select the restriction mode through the Build→Mode menu. A quicker way of changing the current restriction
mode is to click on the area of the statusbar displaying the current restriction mode in the lower right corner, (see Figure
2.39).

Figure 2.41: Segment window, in restricted mode (left) and in unrestricted mode (right).

In unrestricted mode, all generic structural motifs are accessible (see Figure 2.41, right image) and can be used with any
atom in the periodic table. Thus you can construct a system containing, e.g., an octahedrally coordinated hydrogen atom.
Additionally, you can add and delete valency “bonding”) to any atom, increasing or decreasing the number of bonds that
can be made to other atoms. The nature of a bond (single, double, aromatic etc...) can also be changed. The downside to
being able to build almost anything is that, once you have switched to unrestricted mode, there is no guarantee that you
will be able to optimize the geometry of your system, as many atom types may no longer be recognizable to the Sybyl5.2
and the UFF force fields.
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Figure 2.42: Lower toolbar, in restricted mode (top) and in unrestricted mode (bottom). Note the last four buttons in both
images.

The unrestricted mode allows access to four additional tools, not available in the restricted mode: Replace, Add
Valence, Remove Valence and Bond Type, (Figure 2.42).

2.4 Optimization

The optimizer in PQSMOL is a bare-bones minimizer based on a direct BFGS-update of the (approximate) inverse Hessian
matrix, with a preliminary energy-only line search if the starting structure has large residual forces. It cannot be used to
optimize transition structures.

Geometry optimization is performed using the current force field. Available force fields are Sybyl5.2 and UFF. The
current force field is displayed in the upper left corner of the statusbar, Figure 2.43. You can select the current force field
via Optimize→Force Field in the menubar, Figure 2.1.2

Figure 2.43: Statusbar with the current forcefield highlighted.

Tip: You can also change the current force field by clicking on the force field name in the statusbar.

Figure 2.44: Optimize menu

The Optimize menu enables you to set the current force field, set the force field options, check and change the force field
atom types, and set the optimization options.

Optimize→Optimize will start the optimization. This is equivalent to clicking the button in the upper toolbar.
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2.4.1 Force Field Options

Force field options (currently just the van der Waals cutoff), are available in the menubar under
Optimize→Force Field→Options, see Figure 2.45. The force fields in PQSMOL do not have an Ewald summation (or
equivalent) of all pair-wise van der Waals interactions; instead there is a simple cutoff (default 10 Angströms) beyond which
the van der Waals terms are simply neglected. This value can be changed here.

Figure 2.45: Force Field Options window

2.4.2 Optimization Options

There are several optimization options available, Figure 2.46.

Figure 2.46: Optimization options

• Steps sets the number of optimization cycles (default 500)

• GTOL sets the convergence criterion for the root mean square gradient (default 0.0003)

• ETOL sets the convergence criterion on the change in energy from the previous cycle (default 10−6)

• Print Flag sets the verbose output level (for debugging only)

• Calculate Hessian calculates a starting Hessian matrix for the Sybyl5.2 force field only (there is no effect for the
Universal force field)

• Optimization Animation update sets the number of cycles between geometry updates to the Build window.
Setting this option to a value of 1 will cause a structure geometry update on every optimization cycle. A value of 0
will turn off optimization animation.

If both the GTOL and ETOL convergence criteria are satisfied or the maximum number of optimization cycles Steps
has been exceeded, the optimization will stop. In line with similar criteria in the PQS program, GTOL and ETOL are
measured in atomic units.
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Checking the Calculate Hessian box will compute (by central-difference on the gradient) and invert the Hessian matrix
before starting the optimization. This is rarely needed and is unlikely to speed up the optimization; it might be useful in
cases where there appear to be convergence problems.

Normally the optimization will proceed “silently”, i.e., with no print out. Setting the Print Flag (to a small integer value,
the bigger the value the more print out) will write intermediate quantities such as the energy, RMS gradient and RMS
displacement at each optimization cycle to filename debug in the current working directory. As the filename implies, this
might help debug any apparent convergence problems.

Finally the Optimization Animation update gives the number of optimization cycles between each update of the
geometry in the Build window. The default is to redisplay the geometry every 40 cycles. The final converged geometry
is always displayed, in addition to intermediate geometries (depending on the number of cycles the optimization actually
takes). Setting this to a smaller value increases the rate at which geometry changes are displayed. Note that redisplaying
the geometry does take some time, especially for large systems, and too small a value will cause a noticeable slowdown in
the apparent speed of the optimization.

2.4.3 Force Field Symbols

Geometry optimization is performed based on the force field atom type assigned to each atom. The Sybyl5.2 force field
has 33 atom types defined for the following elements: Carbon, Nitrogen, Oxygen, Sulfur, Phosphorus, Hydrogen, Bromine,
Chlorine, Fluorine, Iodine, Sodium, Lithium, Potassium, Calcium, Aluminum, and Silicon. Depending on the number of
bonds and its environment, an atom of one type may be represented by multiple force field symbols. For example, available
Carbon Sybyl force field types are: C.1, C.2, C.3, C.ar. The basic building blocks and the fragment library in PQSMOL

contain molecule segments with correct force field types defined for both Universal and Sybyl5.2 force field. However, when
building molecules from fragments imported from foreign file formats, PQSMOL will attempt to guess the force field types
for the atoms in the imported geometries.

You can manually change the assigned force field symbol of each atom in the molecule by selecting Optimize→Check
Atom Types in the main menu.
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Figure 2.47: Force field symbols

The Force field symbol window, Figure 2.47, shows a list of all atoms and their assigned force field symbols. To manually
change the force field symbol for a given atom, select a symbol from a drop down list on the right of the atom label. The
list can include undefined atom types (which are acceptable in the Sybyl force field but not in Universal). Attempts can
be made to automatically assign any atom types that are currently unknown by clicking on Auto Detect Undefined. In
general this is only likely to occur if the structure was either imported or built in unrestricted mode. Clicking on Auto
Detect All will force an automatic detection of all atoms in the system, whether defined or not.

Any changes to the existing atom types will only be implemented by pressing the the Accept button. The Cancel button
restores the original force field atom types and cancels the operation.

Note: Clicking inside the text entry area of any atom will highlight the corresponding atom in the
Build window.
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Tip: Turn on atom labels with the Labels button in the top menubar to visually identify all atoms.

2.5 Symmetry

The symmetrizer allows you to symmetrize a molecule whose geometry is not exactly symmetrical, and to determine the
point group symmetry of the structure.

Figure 2.48: Symmetry menu

The Symmetry→ Check Symmetry will execute the symmetrizer. This is equivalent to clicking the button in
the upper toolbar.

Figure 2.49: Symmetry output

If any symmetry is found, the geometry will be symmetrized so that the structure does indeed conform fully to the particular
point group. If it seems as if the system should have symmetry, but check symmetry fails to find any (i.e., the point group
is C1) even with a large threshold, then manipulating the structure by hand, e.g., ensuring that groups of atoms are in the
same plane, or reoptimizing with tighter optimization thresholds, may help to locate the desired symmetry.

2.5.1 Symmetry Options

Symmetry options are available in the menubar under Symmetry→Options, see Figure 2.50.

Figure 2.50: Symmetry Options window

The only symmetry option is the symmetry Threshold. The code used to determine the point group symmetry is essentially
a copy of the same code that is in the PQS program. This attempts to recognize symmetry planes and axes of symmetry
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relative to the center of mass of the system, and to locate atoms that are symmetry-equivalent within the given threshold.
The higher the threshold, the more likely that symmetry will be found; however setting the threshold too high may find
symmetry that is really not present. Setting the threshold to a value greater than 1.0 is not recommended.

2.6 PQS Calculation

The procedure for running a PQS calculation involves the following steps:

• building a molecule

• creating a PQS input file

• submitting the PQS job

• displaying calculation results

2.6.1 PQS input file

The PQS input file contains the geometrical structure and a series of commands, instructing the program to perform
calculations on the given structure. PQS input files use a set of specific keywords and a strict syntax. PQSMOL assists
in creating PQS input files through the Job Parameters window. The Calculation→Job Input menu item opens the
Job Parameters window, Figure 2.51.

Note: If the structure in the Build window (the system you are about to do the calculation on)
has not previously been saved as a .pqb file, you will be prompted to save it as such (with a default
filename corresponding to the empirical formula).
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Figure 2.51: Job Parameters window - calculation type

Initially just the current geometry will be displayed in the input file in the text area on the right. Filling in various options
in the window on the left will add lines and keywords into the input file; for example, whatever is typed in the Title box will
appear just above the geometry in the input file on the right. The entries in Job Specifications and Molecule Characteristics
require data to be typed in to make changes, those in Calculation Type and Basis Set/Method involve pulldown menus,
and those in Properties are simple check boxes.
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Figure 2.52: Job Parameters window - basis set
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As shown above in Figure 2.52, a Geometry Optimization has been chosen and DFT has been selected from among the
available calculation methods. The basis set can be selected from a pulldown menu. There are a large number of choices
which cover all of the basis sets stored in the PQS basis library (in the $PQS-ROOT/BASDIR directory). The selected
basis set will appear in the Basis Set box and will also be added to the input file on the right.

Figure 2.53: Job Parameters window - density functional

After selecting the basis set, the density functional can be selected from a list of commonly available functionals, Figure
2.53. The default is O3LYP.

Whichever functional is finally selected will appear in the DFT Method box and also in the input file on the right.
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Figure 2.54: Job Parameters window - semiempirical

If Semiempirical had been selected instead of DFT, Figure 2.54, then no basis set selection is required and the desired
semiempirical method can be selected from the corresponding pulldown menu. Note that the Properties that can be selected
depend on the calculation type, and unavailable properties are grayed out. For semiempirical wavefunctions, most of the
properties can no longer be selected.

The window containing what will become the input file can be edited by hand. Simply move the mouse pointer to the
desired location in the window, click and start typing. Note that anything typed in may be deleted if further selections are
made in the left hand window, so you should only edit the input file when you have made all the major job selections.

2.6.2 Job submission

Once the input file has been prepared, the Calculation→Submit Job menu item will submit the job. This will be serial
only and will run in the background. If so configured, PQSMOL may also submit parallel jobs to run in the background
or to a queuing system such as SGE, DQS or PBS (see following subsection).

50 PQSMol Manual



Build mode

Figure 2.55: Job Output window

Following job submission, the Job Output window (Figure 2.55) will automatically open, displaying both the output file
(upper window) and the summary log file (lower window). Both of these windows will be updated in real time. When the
job completes successfully, the Visualize Output window automatically opens, allowing post-job visualization.

Parallel Job submission

This feature allows a job to be submitted in parallel to the background or to the SGE job queue (assuming it is configured
and is available on your system) using the Parallel Virtual Machine (PVM) software. A window similar to the one in Figure
2.56 appears (the exact details are system-dependent).
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Figure 2.56: Parallel Job Submission window - background job, initial view

All configured nodes are listed in the Background Job tab, Figure 2.56. Each row in the list contains the node name,
the number of available CPUs on the node, an entry containing the number of processes allocated to your job (you can
allocate more processes than there are CPUs, but this is not advisable), an icon representing the state of the PVM, an icon
representing the state of the current job and a status button. Initially, the PVM status of each node is represented with
a question mark icon and the status button is labeled Check. This indicates that the state of each node is unknown. To
check the status of a given node click on the Check button in the corresponding row.

status unknown

no connection

PVM error

PVM off

PVM on

PQS job executing

PQS scratch files present

PQS output present

PQS output and scratch files present

Figure 2.57: Background Job icon legend
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Figure 2.58: Parallel Job Submission window - background job, nodes checked

Figure 2.58 shows the status of the cluster after the Check button has been clicked for each node. In this example node
n1 has a check mark icon, indicating that a PVM daemon is running on that node. The additional icon of a garbage can in
the Job Status column, indicates that there are scratch files (temporary files left over from a previous PQS calculation) on
that node. The label of the status button for node n1 changes to Toggle. This means that there is a connection to that
node and the state of the PVM on node n1 can be toggled (i.e., switched on and off) by clicking on the Toggle button.

The icon shown for node n2 indicates no connection to that node (the “ping” command did not receive a response from that
node). Notice that the label on the status button remains unchanged. Clicking on the Check button will cause another
attempt to “ping” the node.

The icon shown for node n3 indicates a problem with PVM on that node. This is a result of more than one PVM daemon
executing on the node. The status button for this node is labeled Repair. If clicked, it will execute a command which will
kill all running PVM daemons on that node and clean the temporary PVM directory.

The icons for node n4 show that the PVM daemon is not running and that there are scratch files present on that node.
The status button is labeled Toggle and if clicked will add this node to the PVM. Refer to Figure 2.57 for a complete list
of icons and their meanings.

Tip: You can move the mouse pointer over the garbage icon to display a list of scratch files, as
shown in Figure 2.58 for node n4.

Since at least one node is now a part of the PVM (node n1), the Launch Job button and the # Processes entry box
become active; compare Figures 2.56 and 2.58. All PVM processes, in our example three (two computation processes +
the master process), are scheduled to run on the only available node in the PVM – node n1.
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Note: A parallel PQS job is composed of multiple computing processes and one master process.
The master process performs little or no computation. It simply distributes the workload among the
computing processes and gathers the results. It is necessary to schedule this additional job in PVM.
This means that a two process parallel PQS job is in fact a three process PVM job. The number entered
in the # Processes entry box in the job submission window refers to the number of computing (slave)
processes only.

Figure 2.59: Parallel Job Submission window - background job, nodes ready

Figure 2.59 shows the status of a cluster with all nodes up, connected and ready to run a parallel job. You may select a
number of computing processes in the # Processes entry box. The processes will be allocated to the nodes according to
the order in which the nodes were added to the PVM (round-robin). In our example we have a total of five PVM processes
with node n1 added first and n2 added second to the PVM. So the first PVM process (p1 – PQS master process) is assigned
to node n1, the second to n2, and so on, resulting in three processes on n1 (p1, p3, p5) and two processes on n2 (p2, p4).

In our example cluster, we have a 16-CPU system comprising four dual-processor, dual-core nodes, with four CPUs from
nodes n1 and n2 in the PVM. The Launch Job button will submit a 4-processor parallel job. The existing PVM can be
deleted by clicking the Reset PVM button. Old scratch files for the current, named job can be removed on all nodes in
the cluster by clicking the Tidy Job button (see the PQS Manual for more details).

To prevent accidental interruption of an executing job several checks are performed before stopping PVM daemons. Figure
2.60 shows the dialog window displayed when the Reset PVM button is clicked while PQS jobs are executing on any of
the nodes in the cluster. The dialog window in Figure 2.61 is displayed when the Tidy button is clicked while PQS jobs
are executing.
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Figure 2.60: PVM reset warning dialog Figure 2.61: Tidy job warning dialog

Removing a node from the PVM (by clicking on the Toggle button of an active PVM node) while a PQS job is running
produces the dialog window shown in Figure 2.62. Also, if a PQS job is scheduled to run in the queue and the nodes are
removed from the PVM (either by resetting the PVM with the Reset PVM button or by stopping a PVM daemon with
a Toggle button) the dialog window in Figure 2.63 is displayed.

Figure 2.62: Removing nodes from PVM warning dialog Figure 2.63: Removing nodes from PVM while jobs are
scheduled in the queue
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Figure 2.64: Parallel Job Submission window - queue

The SGE tab allows jobs to be submitted into the SGE job queue, Figure 2.64. In this example, a job with the name
aspirin is being set up for submission on four CPUs. Normally the only information the user needs to supply is the job
name (this should already be available in the Job Name box corresponding to the name given in the Job Input section,
above) and the number of CPUs to run on (selected by clicking the up and down arrows next to the # Processes entry
box; alternatively the number can be typed directly into the box). This information will automatically be used in the SGE
script shown in the text area at the top of the window.

The current status of the SGE parallel job queue is displayed in the text area at the bottom of the window. The Show
Queue checkbox is automatically activated when SGE job submission is invoked, so the status of the job queue will be
immediately displayed. In this example two 4-processor jobs (cadion BIG and annulene B) are already running in the
queue, submitted by user “malagoli”.

Tip: To hide the queue deselect the Show Queue checkbox.

Clicking the Submit Job button will submit the SGE script. If all CPUs are currently running other jobs, the job will be
placed in the queue in a “wait” state until CPUs are freed up.
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Note: The configuration for the Job Submission module is stored in the file:

/usr/local/share/PQS/PQSMOL/data/pqssubmit.conf

This is a typical configuration file:

$nodes
n1=4 n2=4 n3=4 n4=4
$paths
PQS: /usr/local/share/PQS/pqs pvm.x
PQS SCR: /scr/$USER
PVM: /usr/bin/pvm
PVM TMP: /tmp
RSH: /usr/bin/rsh
QUEUE STAT CMD: qstat -f
QUEUE SUB CMD: qsub
SGE SCRIPT: /usr/local/share/PQS/PQSMOL/data/sge script
#PBS SCRIPT: /usr/local/share/PQS/PQSMOL/data/pbs script
#DQS SCRIPT: /usr/local/share/PQS/PQSMOL/data/dqs script

Clicking on the Done button will close the Submit window.

2.6.3 Job Results

The Calculation→Job Results menu item invokes the PQS view mode which opens a separate window allowing post-job
visualization and display.

Display options include visualization of molecular orbitals (canonical, localized and natural), electron densities and electro-
static potentials, optimization history (energy/geometry at each cycle of a geometry optimization), dynamics trajectories,
animation of vibrational modes, and simulation of IR/Raman, VCD and NMR spectra.

All of these will be discussed further in Chapter 3.
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View Mode

Figure 3.1: PQSMol running in view mode
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Typing pqsview from the command prompt starts PQSMOL in view mode. Without command line arguments PQSMOL

opens a file browser to choose a file to visualize. If pqsview is followed by a PQS job name (with the extension .out),
providing the job has completed successfully and all relevant job files are available, the job is opened for visualization.

It is also possible to start job visualization in build mode using the Calculation→Job Results menu item.

Figure 3.1 shows PQSMOL running in view mode, visualizing the results of a calculation on aspirin. A successful PQS
job generates several files with various extensions. From among these PQSMOL running in view mode can open files
with extensions .coord, .log, .out and the input file itself .inp. From the .coord, .log and .inp files only the molecular
geometry is extracted. To display the properties calculated in the PQS job, PQSMOL must open the .out file.

Visualization options are available via the buttons in the toolbar at the bottom of the View window or in the menu at the
top.

3.1 View window

3.1.1 Toolbar

Figure 3.2: Toolbar in view mode

The first six icons in Figure 3.2 provide the same functionality that is available in build mode, Figure 2.1.1.

Check Symmetry
Determines the molecular point group symmetry. Unlike in build mode (Figure 2.5), there is no option for varying the
symmetry threshold. Point group symmetry is determined using the same default threshold as in the PQS program itself.

Face Front
Rotates the molecule so that the X-Y plane is parallel with the screen.

Labels
Toggles atom labels.

Coordinates
Toggles the coordinate axes.

Hydrogen Hide
Shows/hides hydrogen atoms.

Info Window
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Toggles the info window.

The next five icons activate the visualization windows: molecular orbitals, vibrational frequencies, NMR, dynamics trajec-
tory and optimization history. If any of these features are unavailable for the current PQS job, i.e., were not calculated,
the corresponding button will be greyed out and the feature will not be accessible.

Molecular Orbitals
Activates the Orbitals window. PQSMOL can display canonical, localized and natural orbitals, the electron density and
the electrostatic potential, Section 3.2.

IR/Raman/VCD Spectra
Activates the vibrational spectrum window. This allows a simulation of the IR, Raman or VCD spectra and animation and
display of individual vibrational modes, Section 3.3.

NMR Spectra
Activates the NMR window. This shows a simulation of the NMR spectrum for each active nucleus, Section 3.4.

Dynamics Trajectory
Activates the Dynamics Trajectory window. This provides an interface for displaying a complete (or partial) dynamics
trajectory, displaying the geometry at each cycle, Section 3.5.

Optimization History
Activates the Optimization History window (shown below). This window provides an energy vs. cycle number plot, Section
3.6

View Modes
Change the molecule drawing scheme. Options are: Ball, CPK, Ball&Stick, Ball&StickII, Ball&StickIII, Tube, TubeII,
Stick and Skeleton.

3.1.2 Menu

The File menu

• Open opens a new file.

• Quit exits PQSMOL.
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The Options menu

• Background displays a color chooser dialog for the View window background, see Figure 2.30.

• Graph Background displays a color chooser dialog for the graph background color, see Figure 2.30. The color
selected in this window will be used as a background color in the Orbitals, Vibrational Frequencies, NMR and
Optimization History windows.

• Graph Plot displays a color chooser dialog for the graph foreground color, see Figure 2.30. The color selected in
this window will be used as the plot color in the Orbitals, Vibrational Frequencies, NMR and Optimization History
windows.

• Graphics opens the Graphics Options window, Figure 3.3.

Figure 3.3: Graphics options window
The Animation Speed slider adjusts the speed of the vibrational frequencies animation. The Spin Speed X-axis,
Spin Speed Y-axis and Spin Speed Z-axis control the rotation speed of the displayed structure, providing the
spin is enabled in the Popup menu, see Figure 3.5.
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The Sphere Quality and the Cylinder Quality sliders control the number of polygons used to draw atoms (spheres)
and bonds (cylinders). Rotation Quality controls the number of polygons used to draw atoms during a rotation.
Perspective Angle adjusts the angle of view. Changes to this value produce a similar effect as changing a lens in
a photographic camera, i.e., setting this value to the maximum of 100◦ will produce a fish-eye effect. The Adaptive
Label Colors checkbox, when selected, causes all atom labels to be drawn with a color that is clearly visible against
the current background color of the View window. When this option is turned off, the labels are drawn with the same
color as the color of their respective atoms. The Antialiasing checkbox turns on antialiasing.

Tip: Turn off antialiasing to speed up image rendering.

The Display menu

• View Mode chooses one of the nine display schemes

• Orbital→Mode chooses one of four surface display schemes: Wire, Points, Transparent, Solid.

• Orbital→Interpolation chooses one of three grid point interpolation schemes: None, Logarithmic, Linear.

• Orbital→Grid Resolution selects the number of points along one axis of the cubic grid. I.e., a resolution of 10
gives a cubic grid of 103=1000 points, a resolution of 30 gives a cubic grid of 303=27000 points.

• Labels toggles atom labels.
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• Coordinates toggles coordinate axes.

• Symmetry checks if the structure in the View window has any symmetry.

• Hydrogen Hide hides hydrogen atoms.

• Center shifts the structure so that it is centered in the View window.

The Window menu

Figure 3.4: Addition to User Library confirmation dialog

• Info toggles the Info window.

• Orbitals toggles the Orbitals window, Section 3.2.

• Vib. Frequencies toggles the Vibrational Frequencies window, Section 3.3.

• NMR toggles the NMR window, Section 3.4.

• Dynamics Trajectory toggles the Dynamics Trajectory window, Section 3.5.

• Optimization Hist. toggles the Optimization History window, Section 3.6.

The Popup menu

The popup menu is activated by pressing the right mouse button inside the view area.
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Figure 3.5: View window - popup menu activated via the right mouse button

• Capture saves the current image in the View window, as a JPEG file. A file save dialog, similar to Figure 2.25, is
displayed to specify a file name.

• Spin animates the rotation of the molecule around the X, Y, and/or Z axes. See Figure 3.3 for rotation speed controls.

3.1.3 Statusbar

Figure 3.6: Statusbar in view mode

The statusbar displays help information about mouse function. The acronyms LMB, RMB and CMB denote Left Mouse
Button, Right Mouse Button and Center Mouse Button, respectively.
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3.2 Orbitals window

Figure 3.7: Orbitals window - initial display Figure 3.8: Orbitals window - electron density selected,
full view

When first invoked, the Orbitals window presents the default view which shows all valence occupied MOs (above an energy
of -2.500 Eh) and the first ten virtual (unoccupied) MOs. Orbital energy levels are displayed in a graph on the left and
the orbital numbers are given in the list on the right side of of the window. The highest occupied orbital (HOMO) and the
lowest unoccupied orbital (LUMO) are indicated (with an ”H” and an ”L”, respectively) next to the corresponding orbital
numbers in the list. The energy levels and the energy range are displayed in the large central window.

The type of orbitals to be displayed can be selected using radio buttons at the top of the window: Alpha or Beta spin
canonical orbitals, Alpha or Beta spin localized orbitals, or Natural orbitals. The default is alpha spin canonical orbitals.
In the example shown in Figures 3.7 and 3.8, the system (aspirin) is closed-shell, and so there is only one possibility and
the other orbital types are greyed out.

The actual orbital to be visualized can be chosen either by selecting the orbital number in the list (probably the easiest)
or by clicking on the desired energy level in the graph. Due to the fact that, in the default energy scale, many orbitals are
close together, it is often difficult to select an orbital for display from the energy level graph. There is a zoom option that
expands the energy scale in a selected region, allowing individual orbitals to be separated and selected.
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For example, selecting the HOMO for display produces the image in Figure 3.9 in the View window.

Figure 3.9: View window - HOMO orbital displayed

The size of the orbital lobes can be changed using the Isosurface level slider bar in the Orbitals window. Using the Cross
Sections slider bars (in the X, Y and Z directions in that order) cuts off the orbitals in those directions, enabling the internal
structure to be more easily seen.

Just as in build mode, the entire structure can be rotated, along with the displayed orbital, by dragging the mouse inside
the View window. This allows the current display orbital to be examined from different perspectives.
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Figure 3.10: Orbitals window - HOMO orbital selected Figure 3.11: Orbitals window - HOMO orbital zoom

Figure 3.10 shows the corresponding Orbitals window to the View window in Figure 3.9. The displayed orbital is highlighted
with a red line in the energy level graph and the orbital number is highlighted in the orbital list.

An orbital zoom in the energy level graph can be accomplished by positioning the mouse pointer just below or just above
the energy levels to be zoomed and dragging the mouse with the center mouse button vertically. A zoom about the HOMO
energy level is shown in Figure 3.11.

Pressing the Full View button displays all orbital energy levels in the energy level graph and allows access to all orbitals
via the list. Because of the extended energy scale (from deep core to the highest virtuals), the energy levels are compressed
and the zoom feature would definitely be required to select orbitals for display from the energy level graph.

The expanded full range energy level graph and orbital list are shown in the Orbitals window in Figure 3.8. Note the
difference in the starting and ending energy levels in the graph and the top orbital number as compared to Figure 3.7. In
Figure 3.8 the electron density has been selected, which forms and displays the density from all the occupied orbitals. The
corresponding View window, displaying the electron density isosurface, is shown in Figure 3.12.
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Figure 3.12: View window - electron density

As in the case of the orbitals, the density surface can be expanded and/or contracted via the Isosurface level slide bar in
the Orbitals window. The electrostatic potential overlaid and color-coded on the density surface is shown in Figure 3.13.

Once the electron density has been displayed, the Electrostatic Potential checkbox in the lower left corner of the Orbitals
window becomes sensitive (this was formerly greyed out - compare Figure 3.7 and Figure 3.10).
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Figure 3.13: View window - electrostatic potential

The electrostatic potential in Figure 3.13 is overlaid on the electron density surface by activating the Display Potential
checkbox. The electrostatic potential is calculated over a grid and smoothly interpolated onto the density surface. In the
default view, the highest potential computed is colored red and the lowest blue, with a graduation in color for all values
in between. If the Linear Scale checkbox is activated, then the potential is colored with respect to an absolute scale and
there will likely be less graduation of color between high and low relative regions of the potential.

3.3 Vibrational Frequencies window

The Vibrational Frequencies window shows a simulation of the IR, Raman or VCD spectra and allows animation and display
of individual vibrational modes.
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Figure 3.14: Vibrational Frequencies window

The default view, shown in Figure 3.14, is the simulated IR spectrum with peak height obtained from the computed IR
intensities. The peaks are fit using a Lorentzian function with half width controlled via the sliding bar (bottom right). The
lowest and highest frequencies have their wavenumbers displayed (in green) at either end of the wavenumber axis.

Individual vibrational modes can be displayed and/or animated either by selecting a specific frequency from the list to the
right or clicking on the actual signal (line) in the simulated spectrum. The most intense signal in the spectrum selected in
this way is shown below Figure 3.15. The mode being displayed is highlighted in red or indicated by a small red arrow in
the frequency window, if the mode has a relatively low intensity.

Figure 3.15: Vibrational Frequencies window - mode #39 selected

The Vectors checkbox turns on the displacement vectors which are displayed in yellow in the View window Figure 3.17. The
entire structure (including the vectors) can be rotated as usual by dragging the mouse in the View window. The direction
of the arrows can be reversed by selecting the Reverse checkbox in the vibrational spectra visualization window and the
vibration can be animated by selecting the Animate checkbox.
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3.3 Vibrational Frequencies window

Figure 3.16: Vibrational Frequencies window - zoom around the selected mode #19

To zoom in on a specific frequency region, position the mouse pointer ins the graph of the vibrational spectrum and drag
the mouse the center mouse button over the region. Dragging the mouse horizontally changes the frequency range and
vertically changes the intensity scale. An expansion about the group of low intensity signals in the left part of the IR
spectrum is shown above, Figure 3.16. To return to the full frequency and intensity ranges spectrum, press the Zoom Out
button.

To change the currently displayed spectrum select one of the three radio buttons labeled Infrared, Raman and VCD in the
bottom left corner of the Vibrational Frequencies window. Note that, if polarizability derivatives have not been computed
(i.e. there are no Raman intensities available), then all Raman active modes are given the same intensity in the simulated
Raman spectrum.
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Figure 3.17: View window - motion in the most IR-active mode of aspirin

3.4 NMR window

The NMR window, Figure 3.18, allows visualization of the simulated NMR spectrum for each active nucleus.
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3.4 NMR window

Figure 3.18: NMR window - C1 selected

The default is to display the NMR spectrum for all atoms of the same atom type as the first listed atom in the input
geometry (in this case carbon). This particular atom is highlighted in the list to the right C1, and is also highlighted in
red in the simulated spectrum. The atom is also highlighted in blue in the View window as shown in Figure 3.19.
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Figure 3.19: View window - C1 selected

The selected atom can be changed by clicking either on the desired atom in the View window or by selecting the atom in
the list in the NMR window. For example, clicking on atom O9 in the list will display the 17O NMR spectrum, with the
peak for atom O9 highlighted in red in the spectrum, Figure 3.20.

Parallel Quantum Solutions 75



3.4 NMR window

Figure 3.20: NMR window - O9 selected

In the main visualize window, atom O9 will be highlighted in green.
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Figure 3.21: View window - O9 selected

The Reference Shift value is set to 0 by default. This value indicates no shift from the computed values. There are three
modes for setting the value of the reference shift, selected by the three radio buttons at the bottom of the NMR window
labeled User, Auto and By Selection. In User mode, you may type in the desired value directly into the Reference Shift
entry. In Auto mode, the reference shift value is set so as to make the smallest calculated shift equal to 0 (the starting value
on the right side of the graph is 0). Finally, By Selection mode adjusts the reference shift value so that the currently selected
peak is at the point 0. The NMR window in all three modes is shown in Figures 3.22, 3.23 and 3.24 for the simulated 13C
NMR spectrum.
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Figure 3.22: 13C NMR Spectrum –by selection reference shift

Figure 3.23: 13C NMR Spectrum – auto reference shift

Figure 3.24: 13C NMR Spectrum – user selected (100) reference shift

The zoom option works in a similar way to the zoom in the simulated vibrational spectrum. Position the mouse pointer in
the NMR window just before the region to be expanded and drag the mouse with the center mouse button over the region.
A zoom around the five right-of-center signals in the 13C simulated NMR spectrum is shown below, Figure 3.25.
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Figure 3.25: 13C NMR Spectrum – zoom

Press the Zoom Out button to return to the default NMR spectrum view.

The default values displayed in the Range End and Range Start entries in the NMR window are taken directly from the
PQS job output, and represent the largest and smallest isotropic shieldings for that atom reported in the output file. The
starting and ending ranges can be adjusted by explicitly setting values in the Range End and Range Start boxes. These
should be greater than the highest value currently shown, and smaller than the lowest, if you want to ensure that the whole
spectrum is displayed.

Adjusting the range from 150 to -200 ppm (normally 140.57 to -157) for the simulated 17O NMR spectrum is shown below,
Figure 3.26. This has the effect of slightly compressing the spectrum.

Figure 3.26: 17O NMR Spectrum – user defined range

The point of doing this is that spectra of related compounds, e.g., isomers, can be individually simulated and adjusted so
they are on the same scale, i.e., the starting and ending ranges for all spectra are identical. This allows a much clearer
comparison between different simulated spectra in reports or publications.

Tip: Right-mouse clicking with the mouse pointer in a given window, e.g., the NMR window, enables
a JPEG image of the graph to be captured.

3.5 Dynamics Trajectory window

The Dynamics Trajectory window, Figure 3.27, provides an interface to visualize a dynamics trajectory.
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3.6 Optimization History window

Figure 3.27: Dynamics Trajectory window

When first invoked the trajectory is loaded, starting at the initial geometry (step 1). This geometry is displayed in the
View window. Selecting the Play button will run through the entire trajectory, displaying each geometry sequentially in
the View window. Selecting the Loop checkbox will play the trajectory repeatedly.

The trajectory can also be played, in either direction (forward on back) via the slider bar, and stepped forward or back via
the Next and Prev buttons, respectively.

3.6 Optimization History window

The Optimization History window, Figure 3.28, provides an energy with cycle number plot.

Figure 3.28: Optimization History window

As can be seen in Figure 3.28, the starting and final energies are given as well as the total number of optimization cycles
(15 in this case). Clicking on any of the ”points” (cycles) in the graph will display the geometry on that optimization cycle
in the View window. Clicking on Prev. or Next button will display the previous or next geometry relative to the currently
selected point, respectively. Pressing the Play button will run through the complete optimization history, displaying all
geometries at all optimization cycles. Selecting the Loop checkbox will repeatedly loop through the entire history, i.e.,
will play continuously. This can be stopped by either deselecting the Loop checkbox or by closing the entire Optimization
History window.
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Chapter 4
Tutorials

4.1 Example 1 - Lactic Acid

To get you started using PQSMOL and PQS , we will begin the tutorials with a simple example molecule – Lactic Acid.

Lactic acid, also known as milk acid or 2-hydroxypropanoic acid, is used in several biochemical processes in the human
body. Its chemical formula is C3H6O3. It is schematically shown in Figures 4.1 and 4.2.

Figure 4.1: Lactic acid structure diagram

Figure 4.2: Lactic acid structure

In this example we will:

• build the molecule

• perform an initial optimization, using the Sybyl5.2 force field

• create a PQS input file

• run a PQS calculation

• examine the molecular orbitals and display the vibrational frequencies

4.1.1 Building the Lactic Acid molecule

Step 1 Start the builder by typing pqsmol at the command prompt.
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We will begin constructing the molecule by first connecting two tetrahedral carbon building blocks. Then we will attach
the carboxyl functional group from the fragment library. The bent oxygen building block for the remaining O-H group will
be attached next, and we will finish by filling all dummy atoms with hydrogens.

Figure 4.3: Segment window with tetrahedral carbon building block selected

Step 2 Insert the first tetrahedral carbon building block.

In the Segment window, Figure 4.3, press the carbon button in the periodic table of elements. The current element is
displayed in large font above the periodic table. Also, all of the available building blocks for the current element are
enabled in the Bond Configuration frame, directly above the periodic table.

The tetrahedral building block is the default building block for carbon, and should already be selected. It is activated by
the last available button in the second row in the Bond Configuration frame, Figure 4.3.

When selected the building block will appear in the Segment buffer, above the Bond Configuration frame. At this point
your Segment window should look like the one in Figure 4.3.
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Note: The green semi-transparent atoms are dummy atoms. These only indicate a place for
attaching other structures.

To insert the block into the build area, select the Add/Attach/Connect tool in the lower toolbar and click the left mouse
button anywhere inside the build area.

Tip: You may also insert into the Build window using the Default tool by right-clicking in the
Build window.

At this point your Build window should contain a single building block shown in Figure 4.4

Figure 4.4: Build window with the tetrahedral carbon building block inserted

Step 3 Attach the second tetrahedral carbon building block.

Confirm that the tetrahedral carbon building block in the Bond Configuration frame is still selected. Attach the building
block to the structure in the build area by moving the mouse over the lower right dummy atom of the structure. The

atom will be highlighted with a circle surrounding it and the cursor will change to , indicating that this atom is a
valid attachment point (Figure 4.5 left image). Press the left mouse button over the the atom to attach the building block,
(Figure 4.5 right image).

Tip: You may also attach the contents of the Segment buffer to the structures in the Build window
using the Default tool by right-clicking over a compatible attachment point in the Build window.

Figure 4.5: Build window - attaching the second tetrahedral carbon building block

Step 4 Attach the Carboxyl functional group.

Click on the Fragments tab in the Segment window, and then on the FUNCTIONAL GROUPS tab. Select the carboxyl
fragment in the list on the left side of the window. The carboxyl functional group appears in the Segment buffer. Click on
the left-most hydrogen atom in the group to set it as the attachment point for the fragment. The Segment window should
now look like the one in Figure 4.6.
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Figure 4.6: Segment window - Carboxyl functional group selected

Attach the Carboxyl group to the right-most upper dummy atom in the build area, by positioning the cursor over the atom
until it is highlighted and clicking. The operation is shown in Figure 4.7.

Figure 4.7: Build window - attaching the Carboxyl group

Step 5 Attach the bent oxygen building block.
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In the Segment window select Building Blocks tab and then select oxygen in the periodic table. The list of available bond
configurations changes. The default bent configuration for oxygen is automatically selected and the corresponding building
block appears in the Segment buffer. We will use this block for the remaining O-H group needed.

In the Build window, attach the building block at the dummy atom on the center carbon closest to the double bonded
oxygen, as shown in Figure 4.8.

Figure 4.8: Build window - attaching the bent oxygen building block

Step 6 Fill with hydrogens.

The Hydrogen Fill tool is activated by the first button in the upper toolbar . It replaces all the green, semi-
transparent dummy atoms with real hydrogen atoms, right image in Figure .

Figure 4.9: Build window - after Hydrogen Fill

Step 7 Preoptimize.

Finally, we finish building Lactic Acid by performing an initial energy . The second button in the top toolbar
executes the optimization. The result of the optimization is shown in Figure 4.10.
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Figure 4.10: Build window - optimization results

Press the OK button to close the Optimization Progress dialog.

Step 8 Check for symmetry

Use the Check Symmetry tool , the third button in the top toolbar, to check for any point group symmetry. There
is no symmetry in lactic acid and so the point group is C1, Figure 4.11.

Figure 4.11: Symmetry dialog

Press the OK button to close the Symmetry dialog.

4.1.2 Creating a PQS input file

PQS package requires an input file to specify the type of calculations to be carried out. Because of the various capabilities
and options available in PQS, there are a large number of keywords and options available in the input syntax. Refer to the
PQS manual for a detailed description.

PQSMOL has a built-in PQS input file generator, that provides a simple point and click interface for creating input files
with the most common options.

Step 9 Create a PQS input file.

Select the Calculation→Job Input menu item to start the input generator. Since we have not named the structure in
the Build window, before proceeding with input creation a Save As dialog is presented, Figure 4.12. The name of the file
is automatically set to the empirical formula with a .pqb extension.

Parallel Quantum Solutions 87



4.1 Example 1 - Lactic Acid

Figure 4.12: Save As dialog

You may keep this name or overwrite it with another. In either case, as soon as the file name is accepted and the file is
saved (by pressing the OK button), the input generator window appears, Figure 4.13.
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Figure 4.13: Input generation window

The left frame of the window contains the input fields, which are used to generate the input file. In the right frame the
input file itself is displayed. Initially, the source of the pqs input file contains only the geometry of the molecule we just
created. As values are entered on the left, the input file is updated in real time. This way you can see how the specific
options appear in the input file.

Enter the title ”Lactic Acid - vibrational frequencies” into the Title: field. This option is used only as a descriptive
title. In the Memory: field enter a value of 20. This option controls the amount of memory the program will request from
the operating system to execute the job.

Note: The unit of memory usage in the Memory: field is a MegaWord (MW).

1 MW = 8,000,000 Bytes ≈ 7.3 MBytes

If, however, the entered value is > 2000 then it is interpreted as words (W)

1 W = 8 Bytes

Lactic acid is a neutral, closed-shell system and we have already determined the point group symmetry (C1) so none of the
molecular characteristics need to be changed.

Select the Geometry Optimization radio button in the Calculation Type and choose Hartree-Fock from the dropdown
menu. Choose the 3-21g basis set in the Basis Set dropdown menu. In the Properties frame activate the Vibrational
Frequencies checkbox. Figure 4.14 shows the final input file.

Parallel Quantum Solutions 89



4.1 Example 1 - Lactic Acid

Figure 4.14: Input generation window - finished input

Press the Done button at the bottom of the window to save the input file. The input file is saved under the same name as
the build file with a .inp extension, O3C3H6.inp in our example.

4.1.3 Submitting the PQS job

Step 10 Submit the job.

With a completed input file we are ready to submit the job. Use the Calculation→Submit Job menu item to run the
calculation. The job is submitted and you should see a confirmation dialog in Figure 4.15.

Figure 4.15: Job Submission - confirmation

At this point PQSMOL begins to monitor the output of the PQS calculation. As soon as output is produced it is displayed
in the PQS Output window, shown in Figure 4.16.
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Figure 4.16: PQS Output window

Two files produced by PQS are monitored. In the top frame, the contents of the .out file (in our example C3H6O3.out)
and in the bottom frame the .log file (in our example C3H6O3.log) are displayed.

4.1.4 Visualizing the PQS job output

Step 11 Visualize the output.

As soon as the job finishes PQSMOL is launched in View mode in a separate window with the current job output file as
an argument producing the window in Figure 4.17.
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Figure 4.17: View window - initial display

Step 12 Examine the calculated molecular orbitals.

Press the Orbitals button the toolbar at the bottom of the View window. Select the HOMO (#24) in the list on
the right side of the window. A line representing the energy level of the 24th orbital is highlighted in red, see Figure 4.18.
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Figure 4.18: Orbitals window - HOMO selected

The corresponding view window, displaying the HOMO is shown in Figure 4.19. Move the Isosurface level slider to change
the isosurface displayed in the View window. Also, experiment with the Cross Sections sliders to produce various display
results.
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Figure 4.19: View window - HOMO displayed

Select other molecular orbitals in the list to see their display in the View window. Try changing the default settings in
the Display→Orbital submenu in the menu at the top of the View window, including changing the grid resolution under
Display→Orbital→Grid Resolution.

Step 13 Save a screen shot from the View window.

Once you have produced a ”publication-quality” image in the View window, you can save it in JPEG format via the popup
menu. Right-click anywhere within the View window and select the Capture menu item. A dialog prompting for a filename
appears, Figure 4.20.
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Figure 4.20: Save Image dialog

You may save the image under the suggested name mol capture1.jpg in the current working directory by simply pressing
the OK button. To turn off the MO display either toggle the state of the Orbitals button in the toolbar or close the
Orbitals window.

Step 14 Examine the Vibrational spectrum.

To display the simulated IR spectrum click on the Vibrational Frequencies button in the toolbar at the bottom
of the View window. The simulated IR spectrum is shown in Figure 4.21.

Figure 4.21: Vibrational Frequencies window - IR spectrum, mode #1 selected

The list on the right side of the Vibrational Frequencies window allows access to all of the vibrational frequencies of the
molecule (30 in this example). Select the first frequency. A small red arrow appears under the corresponding frequency in
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the vibrational spectrum and details for that mode appear in green font at the top of the window (mode number, symmetry,
frequency and intensity). This mode is primarily a twisting about the C-O bond and has a low intensity that does not show
up in the simulated IR spectrum.

Now, activate the Vectors checkbox in the bottom left corner of the window, as shown in Figure 4.21. This will show the
atomic displacements in the vibrational mode #1 as yellow vectors at each atom of the structure in the View window,
Figure 4.22. Activate the Animate checkbox to animate the structure by showing the motion in the vibrational mode #1.

Figure 4.22: View window - vibrational mode #1 displacement vectors

Other vibrational modes can be selected from the list at the right side of the Vibrational Frequencies window or by directly
selecting the peak in the simulated spectrum.
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Figure 4.23: Vibrational Frequencies window - IR spectrum, mode #24 selected

Figure 4.24: View window - highest intensity vibrational mode #24 displacement vectors

Figure 4.24 shows the displacement in the most intense IR mode #24 and Figure 4.23 shows the corresponding Vibrational

Parallel Quantum Solutions 97



4.2 Example 2 - CHFClBr

Frequencies window, with the peak highlighted in red.

4.2 Example 2 - CHFClBr

Our next example is simple to build. The molecule is CHFClBr, Figure 4.25.

Figure 4.25: CHFClBr

This system is chiral and we are going to calculate and examine its VCD spectrum. This involves both an NMR and a
standard Hessian computation enabling both the IR and NMR spectra to be simulated as well.

4.2.1 Building CHFClBr

Step 1 Start the builder by typing pqsmol at the command prompt.

As shown in Figure 4.25, the whole molecule consists of 4 atoms, with the tetrahedral carbon in the center. We will start
with this carbon.

Step 2 Insert the tetrahedral carbon building block.

When PQSMOL is first started, the default current element is carbon. The current element is displayed in large font above
the periodic table in the Segment window and the current element’s button is highlighted with a green background. There
may be multiple building blocks available for a given element. These are listed in the Bond Configuration frame. The
default building block for carbon is the tetrahedral block. The current building block is displayed in the Segment buffer.

At this point we should have the correct building block ready to insert into the Build window. The Segment window should
look like the one in Figure 4.26. To insert the building block, first select the Add/Attach/Connect tool from the toolbar
at the bottom of the window and click anywhere inside the build area.
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Figure 4.26: Build and segment windows - inserting the tetrahedral carbon building block

Tip: You may also insert into the Build window using the Default tool by right-clicking in the
Build window.

Note: If for some reason the building block in your Segment window is different than the one in
Figure 4.26, you can select the tetrahedral carbon building block by clicking on the carbon button in
the periodic table.

Figure 4.26 shows the Build window with the tetrahedral carbon inserted.

Step 3 Connect the fluorine building block.

In the Segment window press the fluorine button in the periodic table. There is only one building block available for
fluorine. Your Segment window should now be identical to the one in Figure 4.27.
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Figure 4.27: Segment window - fluorine building block selected

Using the same Add/Attach/Connect tool move the mouse over the top-most dummy atom in the build area. The
dummy atom will be highlighted with a circle around it. The mouse pointer will change to a plus sign with a letter ”A”,
as shown in the left image of Figure 4.28. This indicates that the dummy atom is a valid attachment point for the segment
in the Segment buffer.

Figure 4.28: Build area - attaching the fluorine building block

100 PQSMol Manual



Tutorials

Click the mouse button over the atom. The result is shown in the right image of Figure 4.28.

Step 4 Connect the Chlorine building block.

Select Chlorine in the periodic table. Again for Chlorine only one building block is available. Using the Add/Attach/Connect
tool attach the Chlorine building block to the right-most dummy atom, as shown in Figure 4.29.

Figure 4.29: Build and segment windows - attaching the Chlorine building block

Step 5 Connect the Bromine building block.

Select Bromine in the periodic table. Again for Bromine only one building block is available. Using the Add/Attach/Connect
tool attach the Bromine building block to the left-front dummy atom.

Step 6 Fill dummy atoms with hydrogen.

Press the Hydrogen Fill button to replace all remaining single-bond dummy atoms with hydrogen. In our case, we
only have one such dummy atom.

Step 7 Preoptimize.

PQSMOL has the capability to perform an initial geometry optimization using one of two built-in force fields. The default
force field is Sybyl5.2 (this can be seen in the status bar at the bottom of the Build window in Figure 4.30) which is perfectly
adequate for this example.
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To run the optimizer press the Optimize button in the top toolbar. Figure 4.30 shows the result.

Press the OK button to close the geometry optimization dialog.

Figure 4.30: Geometry optimization results

Step 8 Check for symmetry.

The symmetrizer in PQSMOL is initiated via the Check Symmetry button in the top toolbar. This operation
attempts to find any axes of symmetry in the built structure, within a specified threshold. If any symmetry is found, the
atoms are repositioned to conform exactly with the found symmetry. Our example molecule has ”c1” symmetry i.e., no
detected symmetry, as shown in Figure 4.31.

Figure 4.31: Symmetry results dialog

4.2.2 Creating a PQS input file

PQSMOL includes a built-in PQS input generator, which lets you create PQS input files in a graphical environment using
text entries, radio buttons, checkboxes and dropdown menus. The result is a text file containing the proper keywords,
formating and syntax required by the PQS program.

Step 9 Save the build file.

Before proceeding with input file creation, we need to name our build file. Use the File→Save menu item to name our
example file. You should now see the dialog in Figure 4.32.
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Figure 4.32: Save dialog

The empirical formula is automatically set as the filename with the .pqb extension. You may change the filename, however
it has to end with .pqb. Click the OK button to save the file under the selected name.

Step 10 Start the input generator.

Use the Calculation→Job Input menu item to start the input generator. The job parameters window is shown in Figure
4.33.
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Figure 4.33: Job parameters window - complete input file

The left frame of the job parameters window contains the user interface objects to create the input file. The left frame
shows the actual source of the input file generated. It is updated in real time, as options are selected in the left frame.

Fill in the options as follows. In the Job Specification frame enter the optional title CHFClBr opt + freq + nmr + vcd.
In the Calculation Type frame select the Geometry Optimization radio button and the DFT item in the dropdown menu.
In the Basis Set/Method frame, select the 6-311g-dp basis set, and B3LYP for the DFT method. In the Properties frame,
check the Vibrational Frequencies, NMR Chemical Shifts and VCD checkboxes. The resulting input file source is shown in
the right frame in Figure 4.33. Press the Done button at the bottom of the window to save the input file.

Note: The input file is saved under the same filename as the build file but with the extension .inp.

Note: If you attempt to start the input generator with an untitled build file, the Save dialog will be
automatically open. The input generator will not execute until a valid filename is assigned to the build
file.

4.2.3 Submitting a PQS job

Step 9 Submit the PQS job.

We are now ready to run the PQS calculation. Use the Calculation→Submit Job menu item to submit the job. You
should now see the confirmation dialog in Figure 4.34.
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Figure 4.34: Job submission confirmation dialog

Press the OK button to close the Job Submission confirmation dialog. As soon as any output is generated by PQS job, it
is displayed and updated in real time in the output window, Figure 4.35.

Figure 4.35: Job output window

Two files are monitored in the job output window: the .out file in the text area at the top of the window, and the .log
file in the bottom. As output is produced it is added to the end of the file and the display scrolls down. Use the scrollbars
on the left side of the windows to scroll up and down through the file.
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4.2.4 Visualizing the PQS job output

When the job is finished, PQSMOL is automatically started in View mode with the job’s output file as an argument,
Figure 4.36.

Note: You can also start the job visualization via Calculation→Visualize Output menu item
in the Build window menubar.

Figure 4.36: View window - initial display

Step 10 Examine the electron density

Press the Orbitals button in the toolbar at the bottom of the view window, to open the Orbitals window, Figure
4.37. The graph on the left side of the window shows the the energy levels for the individual orbitals. The orbital list
on the right contains the calculated orbitals. By default, the list and the graph are limited to displaying orbitals from an
energy level of -2.5Ev and no more than the first 10 virtual orbitals. To display all calculated orbitals press the Full View
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button. The Default View button toggles back the default orbital range.

In the list on the right select Elect.ron density item, as shown in Figure 4.37.

Figure 4.37: Orbitals window - electron density selected

The corresponding View window is shown in Figure 4.38.
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Figure 4.38: View window - electron density displayed

Use the Isosurface level slider in the Orbitals window to change the displayed isosurface.

Step 11 Examine the IR Spectrum

Press the Vibrational Frequencies button in the toolbar at the bottom of the view window. The Vibrational
Frequencies window appears, Figure 4.39, displaying the simulated IR spectrum. Select the most intensive signal in the
IR spectrum by clicking on highest peak in the graph or select #5 in the Frequencies list on the right.After activating the
Vectors checkbox, the atomic displacements in this mode will be displayed as yellow arrows at each atom in the structure
in the View window, Figure 4.40.
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Figure 4.39: Vibrational Frequencies window - most intense IR mode in CHFCLBr

The corresponding View window is shown in Figure 4.40.

Activating the Reverse checkbox will reverse the directions of the arrows. To show an animation of the vibrational mode
in the View window activate the Animate checkbox in the Vibrational Frequencies window. To view other modes either
select another peak in the simulated spectrum or select another mode number in the Frequencies list.
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Figure 4.40: View window - displacements in the most intense IR mode in CHFClBr

Step 12 Examine the Vibrational Circular Dichroism Spectrum

Select the VCD radio button at the bottom of the Vibrational Frequencies window. This will display the simulated VCD
spectrum, Figure 4.41.

110 PQSMol Manual



Tutorials

Figure 4.41: Vibrational Frequencies window - VCD spectrum, Frequency no. 5 selected

The corresponding vibrational modes can be displayed and/or animated in exactly the same way as for the simulated IR
spectrum. Selecting the peak with positive rotational strength (signal pointing up) with the Vectors checkbox activated will
show the corresponding atomic displacements in the View window, Figure 4.40. At the same time the frequency number
will be highlighted in the Frequencies list on the right.

4.3 Example 3 - Methoxy Substitution in Perfluoroanthracene

In this example we look at nucleophilic substitution in aromatic perfluorocarbons; specifically methoxy (-OCH3) substitution
in perfluoroanthracene.

Perfluoroanthracene is shown schematically in Figure 4.42 and its structure in Figure 4.43. The ring carbon substitution
sites are labeled in red and there are effectively three different single-substitution sites: 1, 2 and 9. (Other sites are
equivalent by symmetry.)

Figure 4.42: Perfluoroanthracene showing substitution
sites

Figure 4.43: Perfluoroanthracene

Figures 4.44 and 4.45 show methoxy substitution at site 1. Experimentally, the actual substitution site is often determined
primarily by 19F NMR, and we are going to calculate and compare the 19F NMR spectra for methoxy substitution at all
three sites. Such a study has already been published (M. Muir and J. Baker, J. Fluorine Chem. 126 (2005) 727) and this
example duplicates part of this work, showing how PQS and PQSMOL can be used in a real research topic.
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Figure 4.44: 1-methoxy-perfluoroanthracene (substitu-
tion at site 1)

Figure 4.45: 1-methoxy-perfluoroanthracene

Note: During this tutorial perfluoroanthracene and various methoxy-substituted derivatives will be
constructed, and input files will be prepared ready for job submission. However, all the output files have
been included on the PQSMOL CD, so there is no need to actually run the jobs. Before starting the
tutorial, you should create a test directory and copy all the files in the directory TUTORIALS/EXAMPLE3
on the CD into this directory. Change directory into this test directory before starting the tutorial.

4.3.1 Building Perfluoroanthracene

Step 1 Start the builder by typing pqsmol at the command prompt.

First we are going to construct the parent compound, perfluoroanthracene. This comprises three fused aromatic rings, and
we are going to build this from two existing fragments: benzene in the MONOCYCLIC fragment library, and naphthalene
in the BICYCLIC fragment library.

Step 2 Insert the naphthalene fragment

In the Segment window select the Fragments tab, then select BICYCLIC. Scroll down to select naphthalene. Insert
the Naphthalene fragment into the build area, either by using the Default tool and right-clicking or by using the

Add/Attach/Connect tool . At this point the Build window is shown in Figure 4.46.
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Figure 4.46: Build window - inserting the naphthalene fragment

Step 3 Insert the benzene fragment

Now select the MONOCYCLIC fragment library and select benzene. Move the mouse pointer into the Build window and
insert the fragment in the empty space to the right of the naphthalene fragment. This should add the benzene fragment
into the Build window as shown in Figure 4.47.
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Figure 4.47: Build window - inserting the benzene fragment

As shown, the benzene fragment is oriented differently from the naphthalene fragment. It can be reoriented into the build

plane by selecting the Reorient Selection tool and clicking on any atom in the benzene fragment; the atom will
be highlighted with a green translucent sphere and the fragment can be reoriented by dragging the mouse vertically. The
result is shown in Figure 4.48.
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Figure 4.48: Build window - reorienting the benzene fragment

Step 4 Fuse the naphthalene and benzene fragments

Select the Bond Fuse tool . Click on the (approximately) vertical ring bond in the naphthalene fragment closest to
the benzene. Click on the corresponding bond in the benzene fragment. The two rings will be fused at the selected bonds.
When the segments are fused, the newly fused bond is automatically defined as a rotation bond and designed with a white
torus, Figure 4.49.
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Figure 4.49: Build window - fusing the naphthalene and benzene fragments, attachment

Drag the mouse to rotate about the rotation bond, or select the dihedral angle (180◦) from the rotation preset window that
automatically appears. The final result should be as shown in Figure 4.50.
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Figure 4.50: Build window - fusing the naphthalene and benzene fragments, rotation

Double click inside the build area to clear the selection and set the angle.

Step 5 Add the fluorine atoms

Select Building Blocks tab in the Segment window and select fluorine from the periodic table. In the default Sybyl 5.2 force
field there is only one fluorine building block which will be shown in the Segment buffer. Select the Add/Attach/Connect

tool and replace every ring hydrogen atom by fluorine. You have now built perfluoroanthracene, Figure 4.51.
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Figure 4.51: Build Window - hydrogen replaced with fluorine

The structure can be optimized by clicking on the Optimize button and the symmetry found by clicking on the

Check Symmetry button . The resulting point group should be d2h, Figure 4.52.

Figure 4.52: Symmetry dialog

The entire procedure up to this point could have been considerably simplified, as the POLYCYCLIC fragment library
already contains an Anthracene fragment, which could have been selected directly instead of fusing the naphthalene and
benzene rings. But where’s the fun in that?

4.3.2 Creating a PQS input file

Step 6 Preparing the input file
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Once perfluoroanthracene has been successfully built, the PQS input file can be prepared. We are going to optimize the
geometry using DFT and then compute vibrational frequencies (to characterize the nature of the stationary point, i.e., to
ensure that it is a minimum) and NMR chemical shifts.

Select the Calculation→Job Input menu item to start the input generator. Since our build file has not yet been named,
the File Save dialog (Figure 4.53) will appear, prompting you to provide a filename. By default the empirical formula
will be provided as a filename; this can be changed by typing in an alternative name. Here the file has been named
F-anthracene.pqb (the file extension must be pqb).

Figure 4.53: File Save dialog

Once the file has been successfully named, the input preparation window will appear, Figure 4.54. As shown, the job has
been set up as a B3LYP/tzvp ahlirchs optimization + frequency + NMR.
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Figure 4.54: Input generation window - finished input

Press the Done button to save the changes to the input file.

4.3.3 Submitting a PQS job

Step 7 Submit the PQS job.

Once the input has been prepared select the Calculation→Submit Parallel Job menu item, Figure 4.55.

Note: The Calculation→Submit Parallel Job menu item is only active in parallel installations
of the PQS ab initio package. If you do not have a QuantumCubeTM or other parallel system, this
option will be greyed out and the job will have to be submitted in serial mode; however, all the
jobs in this example have been run in advance, and all output files should be available to you in the
TUTORIAL/EXAMPLE3 directory on the PQSMOL CD, so there is no need to actually run the job.
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Figure 4.55: Parallel Job Submission dialog

The Job Submission window will appear (Figure 4.55). The job is being submitted to the parallel SGE job queue. The job
submission script appears in the large window and requires two user-supplied entries; the job name (F-anthracene) and the
number of processors (in this case 4). Pressing the Submit Job button will send the script to the job queue.

At this point you can exit PQSMOL (unless you actually want to run this job). We will use the files copied from the
TUTORIAL/EXAMPLE3 directory on the PQSMOL CD at the beginning of this example. Click on Done in the Job
Submission window and then select the File→Quit menu item.

4.3.4 Visualizing the PQS job output

Step 8 Capture the 19F NMR spectrum of perfluoroanthracene.

Note: Make sure you are in the directory where the files from the TUTORIAL/EXAMPLE3 directory
were copied.

To view the output of the perfluoroanthracene job, start PQSMOL in View mode by typing pqsview F-anthracene.out
at the command prompt, Figure 4.56.
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Figure 4.56: View window - perfluoroanthracene job visualization

We are going to visualize and capture an image of the NMR spectrum. Press the NMR button in the toolbar at the
bottom of the View window. This will initially display the 13C NMR spectrum (carbon being the first atom listed). To
display the 19F NMR spectrum you can either select a fluorine atom, e.g., F9, from the NMR spectrum window, or click
on one of the fluorine atoms of perfluoroanthracene in the View window. The resulting NMR spectrum is shown in Figure
4.57 (Note the red arrow below the peak corresponding to the selected fluorine atom, F9.)
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Figure 4.57: NMR window - Initial 19F NMR spectrum of perfluoroanthracene

The halfwidth of the peaks can be controlled using the slider bar; sliding this all the way to the left reduces the half width
to zero and simply displays a vertical line, 4.58.

Figure 4.58: NMR window - 19F NMR spectrum with zero halfwidth

The NMR spectra shown in Figures 4.57 and 4.58 display the raw average shielding values as computed by PQS. Experi-
mental chemical shifts are all given with respect to a reference, and a common one for 19F NMR spectra is the 19F signal
in CF3Cl. This can be taken to be 179.42 (see M. Muir and J. Baker, J. Fluorine Chem. 126 (2005) 727) and typing this
value into the Reference Shift entry in the bottom left corner of the NMR window results in the spectrum shown in Figure
4.59.

Figure 4.59: NMR window - 19F NMR spectrum using CF3Cl as reference

Using a non-zero reference of course changes the relative chemical shift values and thus the spectrum range. In order
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to directly compare different NMR spectra, i.e., in this case the 19F spectra of perfluoroanthracene with its methoxy-
substituted derivatives, it is helpful if the different spectra cover the same spectral range. To facilitate this, we are going
to change the Range End entry to 160 ppm and the Range Start entry to 110 ppm. This changes the starting and ending
values on the X-axis of the NMR spectrum, as shown in Figure 4.60.

Figure 4.60: NMR window - 19F NMR spectrum with modified range

Changing the range in this way has the effect of slightly compressing the spectrum.

Finally, we are going to capture an image of the NMR spectrum. Position the mouse pointer anywhere inside the NMR
spectrum graph and press the right mouse button; this will produce a popup menu with a single menu item labeled Capture
(see Figure 4.61).

Figure 4.61: NMR window - Capturing an image of the 19F NMR spectrum

Note: The spectrum image captured in this example has a white NMR plot line on a black back-
ground. This color combination may not be the suitable for printed media. You can change the
background color of the spectrum with the Options→Graph Background menu item and the plot
color with Options→Graph Plot.

Activating the Capture menu item will cause the Save Image As dialog shown in Figure 4.62 to appear, prompting you for a
file name to save a JPEG image. As shown, the default name is nmr capture1.jpg. Change this to, e.g., F-anthracene.jpg
and press the OK button to save the image.
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Figure 4.62: Save dialog - naming the NMR spectrum image

This completes the first part of this tutorial. At this point we have obtained and saved as a JPEG image the simulated 19F
NMR spectrum of perfluoroanthracene. We will now build the various methoxy-substituted derivatives and obtain their
NMR spectra.

4.3.5 Building 1-Methoxy-Perfluoroanthracene

Step 9 Import the prebuilt perfluoroanthracene

Start the builder by typing pqsmol at the the command prompt.

As we have already constructed, and optimized, the geometry of perfluoroanthracene, we can start with that. Select the
File→Import menu item, Figure 4.63.
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Figure 4.63: Build window - importing an existing structure into PQSMOL

The Import Geometry dialog (Figure 4.64) will open, allowing various file types to be imported. We are going to import
the final converged geometry of perfluoroanthracene which is available in the .coord file, F-anthracene.coord. In the File
Filter dropdown list select *.coord (coordinates) and select the file F-anthracene.coord from those shown in the Files
list.

Note: As all jobs for this tutorial have been run in advance, the .coord files for all structures are
already available; normally of course only the .coord file for perfluoroanthracene – the job run in the
first part of this tutorial – would be present.
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Figure 4.64: Import dialog - importing a .coord file into PQSMOL

As the structure is imported into the Segment buffer the dialog in Figure 4.65 should appear. When an existing (and
compatible) .pqb file is found with the same name as the file being imported, PQSMOL will extract forcefield data (atom
types and connectivity) from this file.

Figure 4.65: Import info dialog - geometry imported with an existing .pqb file.
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Note: If a corresponding .pqb is not found in the same directory as the file to be imported, i.e.,
you are importing raw structural data, then PQSMOL will attempt to derive forcefield data using an
internal algorithm. The import info dialog in this case would look like the one in Figure 4.66.

Figure 4.66: Import info dialog - geometry imported without an existing .pqb file.

Press the OK button to import the structure. The result is given in Figure 4.67 which shows perfluoroanthracene imported
into the Segment buffer. Because of the symmetry of this molecule and the orientation of the coordinate axes in the Segment
buffer, the structure is shown ”on edge”. Drag the mouse pointer in the Segment window to reorient the structure.

Figure 4.67: Build window - perfluoroanthracene imported into the Segment buffer

Using either the Add/Attach/Connect tool or the overloaded right-click in the Default tool insert the perfluoroan-
thracene segment into the build area, Figure 4.68.
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Figure 4.68: Build window - perfluoroanthracene inserted

Step 10 Attach the oxygen building block

Select the Building Blocks tab in the Segment window and select oxygen in the periodic table. The result is shown in
Figure 4.69. There are only two possible building blocks for oxygen in restricted mode, either a double bond or a bent
configuration with two single bonds, with the latter, which is the one we want, as the default.
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Figure 4.69: Build window - bent oxygen building block selected

Using either the Add/Attach/Connect tool or the overloaded right-click in the Default tool attach the oxygen building
block to the to top fluorine in the right-most benzene ring. This is the 1-position. The result is shown in Figure 4.70.
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Figure 4.70: Build window - perfluoroanthracene with the oxygen building block attached at position 1

Step 11 Attach the tetrahedral carbon building block.

In the periodic table select carbon. This will show the five building blocks available for carbon, with the 4-bond sp3
hybridized carbon again the one we want the default. Position the mouse pointer over the free valence (the green dummy
atom) on the oxygen atom and right click to attach the carbon atom. The result is shown in Figure 4.71.
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Figure 4.71: Build window - attaching the tetrahedral carbon building block

Finally, press the Hydrogen Fill button in the top toolbar to fill the three free valencies on the newly attached
carbon atom with hydrogens. This completes the building of 1-methoxy-perfluoroanthracene Figure 4.72.
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Figure 4.72: Build window - 1-methoxy-perfluoroanthracene

At this point we could optimize the geometry of 1-methoxy-perfluoroanthracene using the Sybyl5.2 force field. However,
as we have imported the already-optimized geometry of perfluoroanthracene (optimized at our desired level of theory) and
all we have done is replace a fluorine by a methoxy group, then it might be better to start the ab initio optimization using
the structure ”as is” without the force field preoptimization. (The methoxy group can be rotated about the C-O bond to
any desired position.)

We can now repeat Step 6 above and prepare the input file. If desired, you can skip this step and go direct to the examination
of the output. The output file is called F-anthracene-OMe1.out.

4.3.6 Visualizing the PQS job output

Step 12 Capture the 19F NMR spectrum of 1-methoxy-perfluoroanthracene

This is basically a repeat of Step 8 with perfluoroanthracene replaced by 1-methoxy-perfluoroanthracene. View the output
file for the 1-methoxy derivative by typing pqsview F-anthracene-OMe1.out at the command prompt, Figure 4.73.
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Figure 4.73: View window - 1-methoxy-perfluoroanthracene, fluorine atom no. 9 selected

Exactly the same sequence of operations as described in Step 8 should result in the following 19F NMR spectrum, Figure
4.74.

Figure 4.74: NMR window - 1-methoxy-perfluoroanthracene, 19F NMR spectrum
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4.3.7 Building 2- and 9-Methoxy-Perfluoroanthracene and Visualizing the PQS job outputs

Steps 9 through 12 can be repeated to construct and capture the 19F NMR spectra of the 2- and 9-methoxy derivatives.
The output files are available as F-anthracene-OMe2.out and F-anthracene-OMe9.out, respectively. The structures and
NMR spectra are shown in Figures 4.75 - 4.78.

Figure 4.75: View window - 2-methoxy-perfluoroanthracene, atom no. 9 selected
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Figure 4.76: NMR window - 2-methoxy-perfluoroanthracene, 19F NMR spectrum

Figure 4.77: View window - 9-methoxy-perfluoroanthracene, fluorine atom no. 9 selected

136 PQSMol Manual



Tutorials

Figure 4.78: NMR window - 9-methoxy-perfluoroanthracene, 19F NMR spectrum

4.3.8 Comparing the NMR Spectra of perfluoroanthracene, 1-, 2-, and 9-methoxy- perflu-
oroanthracene

All four 19F NMR spectra are shown together in Figure 4.79. The parent perfluoroanthracene is at the top, followed by
the 1-, 2- and 9-methoxy derivatives. Because the ranges were set to the same on all four spectra, they can be directly
compared.
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Figure 4.79: 19F NMR spectra (from the top): perfluoroanthracene, 1-methoxy-perfluoroanthracene, 2-methoxy-
perfluoroanthracene and 9-methoxy-perfluoroanthracene, atom no. 9 selected

In all three derivative spectra, the three main signals observed in the parent are split (due of course to the loss of symmetry)
and are shifted downfield. The spectra of the three isomers are sufficiently different that in, e.g., a reaction between
perfluoroanthracene and methoxide ion in methanol, provided one isomer was dominant in the reaction mix, it should
be possible to determine the actual substitution site – whether at positions 1, 2 or 9 – by comparing the experimentally
observed 19F NMR spectrum with the theoretically simulated spectra.
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